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About this PDF 

 

I hope you find the PDF useful.  I offer it as a small return for all I have learned online from 
the generosity of others, so please feel free to distribute this document.  If you do find it 
helpful, please return the favour by using your knowledge to help out someone else.  I 
certainly know much more about Acrobat than when I started this project.  By the time 
you’ve read this I hope you do as well. 

 

How did this document come about? 

It arose from my struggles in early 1999 to create a CD (using Windows OS) primarily for 
Windows users, but which would still allow Mac users to access the PDF files, albeit 
without icons or use of Reader on the CD (they would use their installed Mac version).  
This PDF document explains the knowledge I acquired from a number of sources to 
address these issues.  Hopefully, the information will help you with similar projects of your 
own.  The solutions described have generally been tested (under Windows 98SE) unless 
explicitly noted otherwise.  There is very little about Unix here as I know so little about it - 
sorry. 

 

So who is this document aimed at? 

Everybody, I hope, but it will be most useful to those who are Windows based and have 
no in-house access to Macs for CD creation purposes.  Most Adobe TS documents 
assume you have Macs, or PCs and Macs - but rarely only PCs.  As one of the latter, I find 
there is a gap in the documentation that I hope this will fill.  A key issue is that presently 
(March 2001), the Windows community is not well served with CD creation software that 
will create true hybrid CDs such as required for alternate Mac or Windows platform use. 

As well as cross-platform issues, incompatibilities between some CD-R media, CD-R 
drives and end users CD-ROM drives can produce odd results.  This is why I touch on the 
benefits of ISO 9660 and the problems that come with its use.  If you are new to this sort 
of project, be careful as you proceed.  If you do any work directly on the Windows Registry 
please, please back it up before you make any changes.   

 

How was this PDF produced? 

With the exception of the flowchart, the entire document was created in Word 97. The 
flowchart was created in Visio v5.0c and saved as a Windows Meta File (.WMF).  The 
vector format .WMF file was then imported as a graphic into Word allowing the original 
image to remain editable without needing Visio.  All hyperlinks and internal bookmarks 
were created in Word, and the Word file properties ('Summary' tab) were filled in before 
the file was completed.  Font choices were restricted to a minimum to avoid file bloat and 
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only common typefaces were used to cut the likelihood of font substitution on the viewer's 
computer. 

The Word document was then turned into a PDF using the 'PDFMaker 4.0' toolbar within 
Word, noting that PDFMaker's options were set to use Acrobat Distiller with the latter's 
print options.  This configuration was chosen as Distiller is more capable of correctly 
interpreting graphics, such as the flow chart.  As the file is intended mainly for browsing on 
screen, the 'ScreenOptimized' option was selected to keep the PDF size down. 

Apart from checking the file the only remaining task in Acrobat was to add a bookmark to 
the flowchart page in the PDF and add some links to that page.  No specialist desktop 
publishing software was needed.  So, it's not that hard  - now you try. 

  

Acknowledgements 

To aid printing either in the US or Europe, the document page size uses the US Letter 
format, this being slightly smaller than European A4.  I have used Courier typeface to 
indicate code or path strings in the text — i.e. what you see or type on your PC. 

Acrobat and Acrobat Reader are trademarks of Adobe Systems Inc.  Windows is a 
trademark of Microsoft Corp.  You are encouraged to study and abide by the Acrobat 
Reader End User Licence Agreement (EULA) before circulating CDs with Reader installed 
on them.  I've included information from some of Adobe’s web pages for Acrobat in the 
Appendices, though if relevant you should check the originals at www.adobe.com. 

I’ve endeavoured to make this document as accurate as my limited testing resources 
allow.  I hope there is enough here both to enable ordinary users to do the simple stuff 
and, as importantly, to see the point at which they should decide to pay for suitably 
qualified external assistance. If your project includes many PDFs or many inter-PDF links 
you may wish to look at the various automation plug-ins and utilities available.  Though 
they are not free like this PDF, they may save you a lot of time and frustration on a big or 
complex project.   For those of you wanting to go deeper into this subject I suggest you 
download relevant parts of the Acrobat SDK and look at the MSDN Library.  

If there are any significant errors, omissions or comments please let me know at 
mark@yeardley.demon.co.uk.  The information is offered as is.  If you need further 
support for Acrobat/PDF see the list of references at Appendix F. 

Mark Anderson 

Portsmouth, UK                March 2001   

 

 [If you are reading this some while after the original publication date it is worth 
checking for either changes to the Acrobat apps or new Adobe Tech Support 
documents on this subject.  In addition, the cross-platform limitations of current 
Windows based CD-R writing software may well have been overcome.  It is also 
worth checking major vendors’ web sites and doing a web search for CD-R FAQs.] 
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Acrobat Reader on CD 

 

Can I put Acrobat Reader on a CD?  

Yes, though you must be using Version 4. The Winter ‘98 Q&A section of Adobe 
Magazine (available on their web site) included the following guidance about Reader v3.x: 

PC/Mac: Can I put Acrobat Reader 3.0x on a CD and run it from the CD? 

No — please don’t!  It may not work correctly, and Adobe cannot support that 
configuration.  Acrobat reader was developed to be installed locally, on the same 
system that will be running it.  We strongly recommend that you install reader onto 
the hard drive of any system on which you will be running it (installing it on a 
network drive is not a good idea.  To install reader you should have 10 to 12.5 Mb of 
hard-disk space. 

In Spring 1999, Acrobat Reader v4 was released as part of the new Acrobat v4 suite. 
Version 4 does offer the flexibility of creating CDs with Reader ‘installed’ on the CD.  This 
allows the user to access PDFs without having Reader v4 or Acrobat v4 installed on their 
system. 

Do be aware that Reader v4 is distributed in two configurations — with and without the 
‘Search’ facility plug-in. Both operate in exactly the same way except the former is able to 
use the Search command to perform full-text searches of PDF document collections 
assuming they have been indexed using Acrobat Catalog. To help distinguish between the 
two configurations, the filenames of the (English language) installers are: 

Search?  Installer   File Size 

No  ar405eng.exe  5.2 Mb 

Yes  rs405eng.exe  6.18 Mb 

The configuration with the Search facility was not ready for the original April 1999 release 
of Acrobat v4 and only became available for download from July 1999.  As a result the 
newer version is not found on early issues of the Acrobat v4.0 application - since 
superseded by the v4.05 application CD.  I understand that the Reader CD (which has all 
the different language versions of Reader on one CD) has the Search version available on 
it.   

Since initial release there have been a minor version update and number of bug fixes 
'updaters' have been released.  As at time of writing, the current version number is v4.05c.  
This full version number is not reported correctly in a number of places on the application.  
So, to check the true version number, open Reader and select menu 'Help->About 
Acrobat Reader…' which will bring up the Reader splash screen.  At top left will be some 
text  '4.05c xxxx xx:xx' - ignore the xxxx bit, which is a date/time stamp of when you 
installed Reader.  Note If you see references elsewhere to v4.06 this in fact confusingly 
implies v4.05a in installed. 
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If you are using v4.05 but the version is not v4.05c you can download a patch which will 
update your installed version to v4.05c.  The file is named 'ac405up2.exe' (c. 2.5 Mb) and 
can be downloaded from the Adobe website.  If you are not a regular used of Acrobat I 
strongly suggest you check the Adobe site for any updates since this guide was written 
before starting your project to ensure you are fully up to date.   

The download file name will in fact indicate the version number and Reader type.  The first 
two letters indicate if the search plug-in is included, ar = Reader, rs = Reader + Search.  
The next three characters are the version number, e.g 40 = 4.0, 405 = 4.05, 409 = 4.09 (if 
there ever is one).  Note that minor version number e.g. v.405c is not shown until the 
program is installed.  The last three letters indicate the language used in the program, e.g. 
eng = English, fra = French, etc.  So ar405fra.exe is the installer for the French language 
version of Reader v4.05 without Search. 

 

What files do Adobe recommend I use? 

Adobe has produced a Technical Support document # 323115 (at Appendix A) which 
explains the official version of how to put Reader v4 on CD.  Note that this document has 
been updated since version 4.0.  The document makes some fundamental assumptions 
that may not help the Windows based user.  The default suggested action is installing 
Reader with Asian font support, help files and installers in English, French and German.  
Consider this: 

Folder sizes on Acrobat v4.05 CD: 

n \Acroread\ = 107 Mb (i.e. all subfolders below) 

n \Acroread\AsianFontPacks\ = 34.5 Mb 

n \Acroread\CD\ folder = 55.4 Mb 

n \Acroread\Installers\ = 17.1 Mb (English 5.41 Mb, German 6.03 Mb, 
French 5.7Mb - all v4.05 non-Search, no patch for v4.05c) 

Strictly following the instructions in Technote # 323115 you would need to include files 
which would take up 80 Mb of the CD, or 114 Mb if you include the Asian fonts installer.  
The layout of the required file set (without Asian fonts) is at Appendix B.  

Consider making a hybrid CD — one with both PC and Mac partitions.  If the Mac files are 
as large as the PC ones you could lose 228 Mb of usable data space to Reader.  

See also the Acrobat Guide PDF section on ‘Distributing PDF Documents on a CD’, 
pp495-497.  For on more on this subject see the ‘Creating your CD’ section below. 

 

Can I reduce the number of program files to save space on the CD for content? 

Happily, yes you can.  Depending on which version of Reader v4 you use (i.e. with/without 
Search), the minimum files needed are 11-14 Mb in size.  To do this, drag only the Reader 
v4 files installed on your hard drive to your CD disk image.   
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If you have a full installation of Acrobat v4.x on your hard drive this can be a bit tricky, but 
Appendix C lists the files needed (for Reader with Search).  Alternatively, install Reader 
onto a PC without Acrobat and then drag the \Acrobat 4.0\ folder and all its contents 
directly into your CD disc image files or onto a ZIP and then to your CD disc image files if 
transferring between PCs.  Note that the “Acrobat 4.0” folder is not a fully compliant with 
some CD format naming rules (as explained later) and that you may need to rename 
some of your files/folders. 

You then need to add a folder with the Reader installer(s) in it; you can get this from the 
Acrobat application CD, the Reader CD (Appendix G) or download from www.adobe.com. 

Note that the licence provisions for Reader demand that you include: 

n The Acrobat Reader installer, exactly as provided by Adobe.  (Find it on the Acrobat 
CD - only the 'without Search' version - or download from Adobe) 

n The Acrobat Reader Electronic End User License Agreement.  (This is a .TXT file that 
Reader installs into the \Acrobat 4.0\Reader\ folder.)  

n Copyright and other proprietary notices included in Acrobat Reader.   

Assuming you copy all the files in \Acrobat\Reader\ folder you should have everything 
required.  

I have not been able to test on a totally ‘virgin’ Windows 95/98 PC but as far as I can tell, 
the Reader application does not install files to any other folders such as the 
\Windows\System\ folder.  It creates any Registry entries it needs when run from the 
CD for the first time on a non-Reader v4.x system (more on Reader and the Registry 
later). 

 

Does the reduced file set method only work for English language versions? 

I don’t think so.  I have not been able to test this but I assume that for languages not using 
complex fonts you should be able to use the above method for the language of your 
choice.  For example, you could install French Reader v4 on to your (French) Windows 
PC, and drag the Acrobat folder to your CD disc image files as described above.  This 
method would probably hold true for any language-specific version except those that use 
double-byte characters (Chinese/Japanese/Korean) or do other tricky things with type 
(Hebrew/Arabic/Thai/etc.).  That said, the 55 Mb file set referred to in the Adobe TS doc # 
323115 seems to include the necessary fonts.  I’m afraid you will need to test this yourself 
if you are using other than simple (non double-byte) languages. 

It also follows that you ought to be able to create a CD with a number of different 
languages installed on it (use differently named top-level folders).  In this case, AutoPlay 
becomes more problematic as you will need to have/have access to programming ability 
or a utility to make a small AutoPlay app that detects the language version of the OS and 
calls the appropriate version of Reader and PDFs 
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Do I need to own the complete Adobe Acrobat v4 application? 

Yes and no.  You need the full Acrobat to create PDFs in the first place, though other 
PDF-writing utilities (with more limited functionality) are beginning to emerge on the 
market.  To use the official Adobe guidance on creating a CD with Reader, you will need 
files from the application CD, and thus the full Acrobat application.  Note though, you will 
only be copying the files from the application CD to your CD-R disc image files, so your 
copy of Acrobat need not be installed onto the PC you are using to create the CD-R.  If 
you wish to create CDs with searchable indexes, the full version of Acrobat is required to 
get access to Acrobat Catalog that allows you to index your PDFs. 

The cut-down installation method I describe can be achieved with only a copy of the 
freeware Acrobat Reader application, but first you will need to install it on a PC and of 
course you will not be able to use it to create any PDFs. 

If your project requires the use of any third-party plug-ins you should check that: 

n they are licensed for use in Reader - most only work in the full Acrobat. 

n they do not require to be running from a hard disk as opposed to a CD. 

n they do not require the presence of any files (DLLs etc.) that may not be installed 
on the user’s system. 



 

 5 

. . . . . . . . . 
 

Setting up content files for the CD 

 

Where do I put my PDFs and other content files for the CD (Windows OS)? 

The way to ensure your content behaves as expected is to work out your layout 
beforehand.  Create the folder/file layout on your staging drive rather than trying to create 
a layout 'on the fly' in your CD-R software. 

As long as all your PDFs, media files (movies etc.) and indexes are on the same physical 
partition/hard drive any inter-file links in Acrobat will be relative.  It doesn’t matter if the 
drive you are working on is on a server, removable or suchlike.  The key point is that all 
files are on the same drive.  This ensures the links are written as relative paths.  Thus as 
long as the relative folder structure of the staging area is maintained on the CD, the links 
will work when located on a different drive, i.e. your CD. 

For example, you create links between your project's PDFs whilst they are scattered 
across your C: and D: drives and you then run the project on a user's CD drive 'E:'.  A file 
originally linking from D: to C: drive will look will look for the target file on the user's C: drive 
instead of E:.  By comparison, links originally from D: to D: are relative and if run on E: will 
look on E: for the target and thus work.  

It is worth noting that when Reader is run from a hard disk the default folder for Reader's 
‘Open’ menu command is the folder containing its executable (..\Acrobat 
4.0\Reader\) but when run from CD, the default folder is the 'root' drive of the CD, i.e. 
the top level folder of the CD.   

If your content involves more than one PDF and you have created links between the 
PDFs, consider creating a ‘contents’ PDF with links to PDFs in other folders. It is also 
good practice to keep the content files separate from the application files, perhaps by 
placing all the content in a folder \content\.   If you are using media such as movie clips 
you may wish to put them in a content sub folder to keep them apart from your PDF files.  
If your media clips use helper programs such as QuickTime, check whether this can run 
from CD or not.  If not make sure to include an installer for the helper application on your 
CD, ideally placed in the folder holding other necessary folders such as those for Reader.   

If you need to use ISO 9660 filenames (8.3 names) on your CD, you should take naming 
limitations into account early on and ensure the content files are generated with suitable 
file and folder names to avoid more work before being able to create indexes and the CD 
disc image.  If you are using a PDF 'contents' file with links to your other PDFs, user will 
not need to use Windows Explorer/Mac Finder and so "My Very Long Descriptive 
Filename.PDF" is no more useful than an 8.3 compliant "CH2_PT3.PDF".  However, you 
might wish to arrange the PDFs in sub-folders to aid the user to find the appropriate files 
via a 'File->Open' dialog.  Don't forget to decide the layout and sub-folder names before 
you start linking files. 
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Can I include indexes with my PDFs? 

For a more sophisticated CD product, you can also include an Adobe Catalog-generated 
index file (.PDX) for your PDF(s).  The Catalog program is installed as part of the full 
Acrobat suite.  Note that to use these facilities your CD must have the version of Reader 
that includes the Search plug-in.  The plug-in then uses the indexes as the source 
reference for user defined searches.  As well as the PDX file, Catalog creates a series of 
other folders that are part of the index so don't forget to include these in your CD set up. 

If you observe the same caveats about folder structure for your PDFs as explained in the 
section above, this system will work correctly when burned to CD and can enhance the 
quality of the information you are supplying.  If you are using a Catalog index, there is 
even more reason to set out your CD with all (content) PDFs in one folder, to reduce the 
chance of creating broken links when moving the files to your CD disc image.  

Having created your index (in the correct location), open your PDF and select File-
>Document Info->Index… which will pop an ‘AutoIndex’ Dialog.  Click the ‘Browse’ button 
and navigate to your .PDX file, click OK, and save the PDF.  Repeat as required for an 
PDFs requiring the indexed search capability.  Now, when the PDF is opened with 
Reader+Search, the index is automatically called into use, so potentially a whole collection 
of indexed PDFs on the CD can be searched and opened.  Note that if you are using 
indexes you will see briefly a couple of extra dialogs as Reader opens (‘Starting Search 
Engine’ and then ‘Attaching Indexes’).  If you see these dialogs during testing it is a useful 
tell-back that your PDF has been linked to an index.  

Part of the Acrobat v3 suite, Catalog v3.0 was a 16-bit application so it indexed the short 
form of file names. It was necessary to either stick to short names, or use a CD creation 
method that preserved the original short file names. If you need to share your PDFs/PDXs 
with users with Reader 3 consider sticking to 8.3 names.  Of course, as long as they use 
the Reader on your CD they will be using Reader and Search v4. 

To make the most of these search features you should take the time to read the sections 
in the Acrobat Guide about Indexes and links.  If you are reading this PDF in Acrobat v4 
(not Reader) this link will open the Acrobat Guide which is in PDF format and called from 
the Help menu or located on your hard disk at (English language version default): 

C:\Program Files\Adobe\Acrobat 4.0\Help\ENU\Acrohelp.pdf. 

Or on the Acrobat CD at: 

[CD drive]:\English\HELP\Acrohelp.pdf 

(see Acrobat Guide PDF pages 414-458, ‘Indexing Document Collections’ and ‘Searching 
Catalog Indexes’) 

 

Can I open my PDFs in Reader at a particular page? 

Yes, there are 2 possible methods.  The first is to set the PDFs open preferences under 
the menu File->Document->Open.  Here you can set a page number and the document 
will always open at that page, unless called by a link from another PDF - which is the 
second method. 
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What it is not possible to do at present is enter a page number into a command line 
argument when opening Reader & a PDF from Windows (see more on Command line 
statements).   

 

Can I pre-set non-default preferences for Reader? 

Yes and no.  Most preferences changed in Reader require the application to be restarted 
before the change is effective.  Such a procedure negates the value of AutoPlaying your 
CD.  There are two other methods you could choose. 

The first is to run a document level JavaScript which will allow you to change a very limited 
number of preferences: full screen mode, display both toolbars, display horizontal toolbar, 
display vertical toolbar, display cross-doc links in the same window.  The last causes each 
PDF to be closed as the next is opened - if called by an inter-PDF link.  A short tutorial on 
how to create and use a document level script is available on my web site. 

More complex, and not for the inexperienced is to pre-write the necessary keys to the 
users Registry before running Reader.  As this is not possible using an autorun.inf file it 
falls outside the scope of this document.  
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Creating an AutoPlay CD  

This chapter is primarily devoted to making CDs AutoPlay on a Windows PC but there is 
less information regarding Macs as they tend not to use such a feature.  Reflecting 
feedback from users of v1.x of this PDF I have rewritten much of this chapter, to give a 
description that non-programming folk can follow.  The system used is quite simple but 
there are a number of caveats you need to understand before you start work. 

What are AutoPlay CDs? 

In 32-bit versions of Windows (95, 98, 2000, NT4) the is an ‘AutoPlay’ facility that allows 
programs to be run as soon as a CD is inserted and read, without user intervention. To 
access this function your CD must include a special file named autorun.inf in the root 
folder of your CD (more on the 'root' folder below).   

The file name is recognised by the windows OS and the CD will ‘AutoPlay’ according to 
the information you supply.  Note that your autorun.inf file must be in the Windows partition 
of your CD if using the hybrid format 

Can I create an AutoPlay CD for Macs?  

Answer: you don't.  This is because: 

n it is not the normal style on the Mac.  

n many Mac users turn this feature off, as a serious virus was once spread that 
way. 

The Mac layout style is for a folder to open automatically when the CD-ROM is inserted, 
containing icons that do obvious things. Using Adaptec’s Toast (a Mac CD making 
program), it is just a matter of having the appropriate window open for the source partition 
when you set up to burn the CD.  

Such things may be less easy to achieve authoring hybrid CDs from the PC and will 
depend on your utilities and degree of access to a Mac to set-up the Mac files and folders.  
CD formats are discussed further below. 

 

Some things you should understand before starting 

If you are familiar with the paragraph headings below, you can skip this section.  It is 
included to help out those with little or no Windows programming experience. 

Root Folder.  

The term is confusing to many people but is important for this technique.  The 'root' folder 
is the top level folder on your CD and is equivalent location to the C:\ folder on your hard 
drive.  From a layman's perspective you could say the root isn't a folder as you don't see a 
folder icon in Explorer, just the drive's icon.  Whatever way you find comfortable to 
understand it, the root folder is important as it is the first folder to get read, i.e. the OS has 
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to read through C:\ on its way to C:\anyfolder\otherfolder\.  Thus you put your autorun.inf 
file in the first folder to get read as your CD spins up in the drive. 

CDs and drive letters.   

In Windows a CD drive is allocated an identifying letter, like a hard drive, with the CD drive 
letter sequentially following those of the hard drives.  An ordinary desktop with one drive of 
each type will have hard drive C: and CD drive D:.  With two hard drives and a CD this 
would make the CD drive E:, C: and D: being the hard drives.  Your problem as the CD 
author is that you can't rely on the drive letter of the CD drive being the same on your PC 
as on the PCs of all your CD's users.  This is just one of the reasons for stressing the need 
for relative links in the earlier section on setting up your content. 

Path statements and path syntax.  

A path is the system's roadmap to find the location of a file.  You may also see a path 
statement referred to as a 'string'; don't worry, for your purposes it means the same thing.  
If 'myfile.pdf' is in folder \bar\ inside folder \foo\ on the D: drive, it has the path 
D:\foo\bar\myfile.pdf.  The same location on drive whose name you don't know, e.g. your 
CD, would be \foo\bar\myfile.pdf (note the backslash at the start of the path). In the 
autorun.inf, path statements have one important difference - there is no backslash at the 
start of the path.  Thus for an autorun.inf file you would use foo\bar\myfile.pdf for the last 
example.  Windows is not case sensitive to upper/lower case characters so don't worry 
about whether file or folder names are capitalised.  The same is not true in other operating 
systems such as Unix or with web URLs. 

Command line and command line arguments.   

A command line is a path statement you give to the operating system to allow it to run a 
program.  Try this out now.  Click the Windows 'Start' button and select 'Run' from the pop-
up menu.  In the run dialog type 'C:\Windows\Notepad.exe' and click the OK button. 
Notepad opens - you just executed its command line. Some programs also allow 
'arguments' as an additional statement to indicate a file to be open by the program when it 
runs.  Create a text file called test.txt and save it in C:\Windows.  Now repeat the exercise 
but type 'C:\Windows\Notepad.exe test.txt'.  Notepad runs, displaying your test file (now 
close Notepad and delete test.txt). In the example the file has no path only because it is in 
the same folder as the program. Note that the program path and the argument path are 
always separated by a single space. 

Using double quotes in paths.   

32-bit Windows bought users the ability to use folder and file names over 8 characters 
long and with spaces in them, e.g. \foo bar\ and 'my long descriptive name.txt'.  However, 
try using paths with spaces in the names and most likely you will get an error.  Why?  
Because when the system reads the string of characters, it interprets the space as the end 
of the path, when in fact it is only part way through.  How do you get round this?  Use 
double quotes, e.g. "\foo bar\".  The quotes tell the system to treat everything between the 
quotes as one statement.  Not surprisingly, you may not use the " character in a file of 
folder name.  You can still use double quotes with 8.3 names/paths - in fact using double 
quotes is a good habit for the novice to use to avoid difficult to diagnose errors.  Thus: 

\myfolder\myexe.exe myfile.txt  works OK 
"\myfolder\myexe.exe" "myfile.txt" works OK 
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\my folder\myexe.exe my file.txt is likely to fail 
"\my folder\myexe.exe" "my file.txt" works OK 

At this point, you may see that to save yourself a lot of trouble there is much sense in 
sticking with simple folder names with just 8 letter or number characters.  My experience is 
you use more fancy naming - which you may feel is more user-friendly - at your peril. 

It is important to understand that the autorun.inf’s command syntax is subtly different to 
that used with either Windows shortcut (.LNK) files or the Windows Start->Run command.  
These differences can easily catch you out.  So, do not use these other methods to test 
the correctness of your autorun.inf path strings as you will fail to trap errors correctly.  I’ll 
give more detail below about AutoPlaying hard drives for test purposes. 

That covers the background.  Now it is to start programming your autorun.inf file. 

 

What is the general format of an autorun.inf file? 

The .INF file uses a basic text format that may be created or opened using Windows' 
Notepad.  The normal default consists of 3 lines of information: 

[autorun]  (required heading - in square braces) 

open=  (path to program.exe plus optional command line arguments) 

icon=  (name of icon (.ICO) file in root folder) 

If the icon is located anywhere other than the root folder you are supposed to use 
'defaulticon=' instead of 'icon=' in the second line.  However, from experiment 'icon' 
seems to work in all cases. 

The autorun.inf file allows you to specify (open=) the path of an application to run and, if 
command line arguments are accepted, the file the application should open.  Additionally 
(icon=), an icon can be specified which will show instead of the CD drive icon in Explorer 
and Windows folders when the CD is mounted. 

 

How do I get my AutoPlay CD to run Reader when the CD is inserted? 

In the sections below you will see how to create an autorun.inf file that will open Reader in 
the default folder location \Acrobat 4.0\Reader\ and open a file my.pdf in the folder 
\content\.  A cut and paste example of this is given after the explanation. 

The ‘open’ statement - example with only the program opening.   

Here you call the program by providing the path to its executable (.EXE) file.  For our 
Acrobat reader layout this is   As the autorun.inf path syntax starts without a backslash, 
you use: 

open="Acrobat 4.0\Reader\AcroRd32.exe" 
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Note that double quotes are required as the folder \Acrobat 4.0\ contains a space.  Without 
the quotes, the system would read the line as 'open=Acrobat' with the argument 
'4.0\Reader\AcroRd32.exe' which is not what you want. 

The ‘open’ statement - example with program and file opening. 

Building on the example above you now add the argument for your PDF file's path: 

open="Acrobat 4.0\Reader\AcroRd32.exe" "content/my.pdf" 

Strictly speaking the argument for the file does not need quotes, but I've included then to 
help highlight the space you must leave between the program path and the file path.  Note 
that each of the statements is enclosed in its own set of double quotes.  Using a one set 
for the whole line would cause the system to see only one (incorrect) statement. 

This example assumes ‘my.pdf’ is in the \content\ folder.  What happens if you just put 
"my.pdf" for the file argument?  Here, behaviour differs from hard drive to CD.  On the hard 
drive, no folder information will cause the application to looking the Reader EXE's folder 
for my.pdf.  On the CD, it is the root folder of the CD that the system will look to for my.pdf.   

The ‘icon’ / 'defaulticon' statement.   

defaulticon="Acrobat 4.0\Reader\AcroRd32.exe,1" 

This statement is optional and tells Windows what graphical icon to show in Explorer for 
the CD drive when your CD is mounted.  In your example, to save creating an icon you 
use one of the icons embedded in the Reader application.  The notation ',1' at the end of 
the example line above is to indicate you wish to use icon #2 contained in the 
AcroRd32.exe file (icons number upwards from 0 not 1).  In fact, Reader has 5 embedded 
icons; you might also like to choose from #0 which is the Reader application’s icon, #1 
which is a PDF file icon or #4 which is a file icon for an FDF Acrobat Form file. 

If you have ready made icon of your own, place it in the root of the CD and replace the  
defaulticon line with: 

icon=myicon.ico 

Note that you don't need to give an icon number with an .ICO file.  If you know a little bit 
about graphics you can have a go at making your own icons.  Although the icon image file 
is in bitmap form, you cannot simply change the extension of a bitmap from .BMP to .ICO 
and expect it to work. 

The quick way to get a professional looking result when using Acrobat Reader on your CD 
is to use Reader’s icons as described. 

Putting the statements together. 

The example below is for an autorun.inf file which will both AutoPlay Reader and in turn 
open a PDF. You can create it easily using Windows’ Notepad.  Open Notepad, then cut 
and paste the text shown below between the hash marks into the Notepad file and ‘Save 
As’ with the name ‘autorun.inf‘.  Now make sure this file is included in the root (top level) 
folder of your CD when you burn it. 
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#### 

[autorun] 

open="Acrobat 4.0\Reader\AcroRd32.exe" content\my.pdf 

defaulticon="Acrobat 4.0\Reader\AcroRd32.exe,1" 

#### 

(Important Note: the paths have no backslash (\) preceding the first folder or file name.  
Don't ignore double quotes (") - see previous notes) 

 

Extending the functionality of Autorun.inf 

There are also some extensions to the autorun.inf file you can use that will put shortcuts 
on the context (i.e. right-click) menu of the CD's icon.  For example, add this to your 
autorun.inf (below the icon= line) as lines 3-4: 

shell\read\command=notepad.exe readme.txt 
shell\read=Read M&e First 

The CD icon context menu will have a new item, “Read Me First” that launches Notepad 
with the readme.txt file from the CD loaded; 'E' will be set as the hotkey.  Don't forget the 
default folder location on the CD is the root, which is where your readme.txt file should go.  
The ampersand (&) character in the second line denotes the hotkey letter, which is 
underlined in the menu.  So Rea&d Me First would make ‘D’ the hotkey, and the menu 
item would appear as “Read Me First”.  If you use hot keys (you don’t have to), do ensure 
that the letter you wish to use isn’t already assigned to a standard Windows context menu 
choice, such as Copy, Properties and Rename.  The first listed menu entry for any hotkey 
gets executed. 

As for the open command, you can give a path to the file you wish to open (note as for the 
‘open=’ and ‘icon=’ lines, no leading backslash is used): 

shell\read\command=notepad.exe mydocs\readme.txt 

You can add more than one such context menu shortcut by tweaking the ‘read’ verb: 

shell\read1\command=notepad.exe readme.txt 
shell\read1=Read M&e First 
shell\read2\command=notepad.exe acrobat4\reader\(c)adobe.txt 
shell\read2=Read Adobe E&ULA 

This adds “Read Me First” and “Read Adobe EULA” items to the CD’s right-click context 
menu.  Items are added in the order they are in the autorun.inf.  For more menu entries 
use ‘shell\read3\..’, ‘shell\read4\..’ etc.  Note that in the EULA path statements 
no double quotes are required, as both paths are 8.3 compliant with no spaces. 

If you want to extend your autorun.inf's functionality further, consult the online Microsoft 
Knowledge Base and search for “AutoPlay” and "autorun".  
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For utilities that extend AutoPlay functionality without requiring programming knowledge 
see Pollen Software’s programs. 

 

How do I test my autorun.inf file? 

You can test the AutoPlay function by placing the autorun.inf on the root of one of your 
hard drives.  I would not recommend using your boot drive (normally = C:) if you only have 
the one hard drive and are not familiar with Windows as errors in your autorun.inf could 
create problems you might find difficult to resolve without assistance. 

How do you use the .INF file of your hard drive?  First, copy the file to the root of the drive 
you will use, e.g. to D:\.  Next, in Explorer or the 'My Computer' window refresh the view 
(shortcut = F5 key).  This causes the system to re-read the folder/file structure.  Now you 
can: 

n  Double-click the test drive's icon as you would for a CD and check that the 
correct application and file open. 

n Check the correct icon is shown for the test drive. 

n Right-click the drive icon and check for the appearance of any extra menu items 
you have programmed.   

n Check the keyboard shortcuts for the menu items function correctly. 

n Check the menu items function as intended, e.g. calling files. 

n Check links from your PDF to other content works.  If the links are relative (as 
previously described) then they should work regardless of whether they are on 
the same drive as you are testing or not. 

You can also make floppy, Zip, Jaz drives etc. work as well which is described in MS 
Knowledge Base article #Q136214 “How to Test Autorun.inf Files”. However, this does 
involve a Windows Registry edit  - not recommended to the unfamiliar. 

If you try test calling your initial content PDF via a Windows shortcut (.LNK), do realise that 
you will use slightly different path strings as the .LNK file needs explicit references to the 
drive letter and includes an opening in the backslash.  Thus for the earlier example: 

.INF file   open=foo\bar\my.pdf 

.LNK file, target field D:\foo\bar\my.pdf 

Although the .LNK method will check the PDF is in the right place it will not properly check 
the syntax of your autorun.inf file. 
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What if AutoPlay has been disabled? 

Users, or more likely IT staff, may disable Windows’ AutoPlay feature.  You can’t do 
anything automatically with your CD to re-enable AutoPlay, as the user’s PC will not read 
the autorun.inf file.  In the next section I include tips to get round this problem. 

However you can get the user to re-enable AutoPlay.  It is only a check box but the trick is 
finding it.  In Windows 98 use Start->Help, select the Index tab and type “To make CDs 
play automatically when inserted in the CD drive” and you will be given step by step help. 

Alternatively (both Windows 95 and 98)  

n Click Start->Settings->Control Panel and double-click the System icon 

n Select the Device Manager tab of the System Properties dialog box.  

n Click the plus sign next to CD-ROM, right-click the device you want to use, and 
then click Properties.  

n Click the Settings tab.  

n Select the Auto insert notification check box. The checkbox is ticked for ‘On’ 
and clear for ‘Off’ 

I don’t have the details for NT but it should not be dissimilar except that you may need to 
pay attention to the degree of user permissions allowed and you may need "administrator" 
privileges to achieve the change (consult your IT staff - if you have any!). 

 

Other Considerations 

You should consider putting a “ReadMe” text file in the root of your CD.  The primary 
purpose is to help users who may be having a problem running the CD’s contents, so you 
will help them by making sure the file (or a copy of it) is in basic text form, i.e. .TXT 
extension.  Check you can read the finished file in Notepad - and in Mac's SimpleText if 
you are working cross-platform.  Things you might choose to include in the file are: 

n A brief description of what is on the CD and how you intend it to be used. 

n An explanation of how to open the Reader v4 on the CD (assuming AutoPlay has 
failed) from the Windows->Start->Run dialog and how it can be used to read the 
PDFs on the CD. 

n How to enable AutoPlay. 

n An explanation of where the content PDF files are, i.e. in Explorer, especially any 
PDF which acts a table of contents linking to other PDFs. 

n An explanation that regardless of the existence of v2 or v3 Acrobat apps on their 
system, running the Reader v4 installed on the CD will not interfere with their PCs 
association of PDFs with apps on their hard drive(s).  
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n An explanation that if the user has v4.x Acrobat and/or Reader on their hard drive, 
changes to the screen layout (e.g. hiding toolbars) when running from CD will be 
reflected in the hard drive versions when next used. 

n If using multiple languages, an explanation of how to start each language version. 

n The location of the Reader installer (see also note below) and how to install 
Reader on their hard drive.  Think about the presence of older versions and how 
they can be uninstalled. 

n Any special instructions, e.g. how to find and install helper apps such as 
QuickTime. 

n A contact or technical support number in case users have problem or an error to 
report.  Also consider relevant URLs (web addresses) for Adobe’s Acrobat Tech 
Support files. 

Do note that if you run the on-CD version of Reader without calling a PDF file as well, 
Reader's File->Open dialog will open looking at the root of the CD.  There is thus 
something to be said for putting some/all of your general .TXT and .PDF info and index 
files on the root of the CD.  This aids the person who is looking at the CD in Explorer or 
whom has managed to open the Reader on the CD but does no know where the content 
files reside. 

Reader installer files.  Do be aware of the possible issues of Reader v4 being installed 
before v3 is removed (see section in compatibility between versions).  Despite the warning 
message seen in such a situation, v3 and v4 or reader can happily co-exist.  However, a 
problem does arise when either one of the versions is uninstalled as it removes files the 
other version needs.  The remaining version will require reinstalling.  If concerned put v3 
and v4 installer on your CD. 

Using Windows shortcuts on the CD.  This method does not work as it is not (or not easily) 
possible to save the .LNK file without drive letter info - regardless of what you type in the 
properties dialog.  If you try this, Windows 98 gives an error dialog and Windows 95 
silently appends the drive letter of the drive you created the file.  I believe that with 
programming tools/expertise you can amend an .LNK file that would link ‘internally’ from 
one CD location to another but such expertise is outside the scope of this document.  Try 
to use links between your PDFs to guide users around content.  If you have to run more 
than Reader, then you will need some type of AutoPlay application. 

 

Likely errors when testing your autorun.inf 

These are common errors that occur: 

n Windows dialog captioned “Program not found” saying it can’t find ‘acrord32.exe’.  
Check the syntax of the path to the reader exe file in ‘open=’.  Most likely you 
have started the path with a backslash when none is required.   

n Reader opens and gives one or both of the following “There was an error opening 
this document. The file does not exist” or “There was an error opening this 
document. The path does not exist”.  Check your PDF path statement - you are 
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probably using folder/file names with spaces in them which it appears the 
AutoPlay function will not accept as valid 

n No icon or wrong icon.  No icon - check the ‘icon=’ or 'defaulticon=' path and 
ensure there is no opening backslash.  If the icon is wrong, check the icon 
number (they number from 0 not 1.) 

n Changes made to the autorun.inf are not reflected.  If editing the file in Notepad, 
check you saved the changed version before re-running.  Always refresh Explorer 
(press F5 key with Explorer or ‘My Computer’ window open) before re-testing 
after changing the autorun.inf. 
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Cross-platform issues and CD formats  

 

Whilst reading this section, a good external reference to have to hand is Andy McFadden’s 
CD-R FAQ (based on newsgroup postings).  The FAQ covers, types of CD, CD formats, 
software, media and lots of novice’s “What is/How do I?” queries.   Having no experience 
of or access to Unix, I have not covered this format though Acrobat does have a Unix 
version.  My comments are mainly addressed at Windows/Mac cross-platform use. 

Cross-platform issues 

If you are only distributing for a Windows PC audience you can go ahead and skip the rest 
of this section.  However, if your intended audience is cross-platform and you are PC-
based you have a few problems.  Unfortunately, Macs and PCs use different file systems 
making it difficult to read media for the other types of computer without some care.  
Additionally, the Mac and Windows Operating Systems use different methods to identify 
the application required to open a given file format.   

The Mac uses two 4-character tags (file 'type' and file 'creator') to define the file and stores 
this data in a ‘data’ fork and the type/icon/etc. information in a ‘resource’ fork.  Windows 
uses a 3-character extension (the .3 of the 8.3 filename in Windows 3.x) to define the file 
type and stores all the information in one file.  

The Mac relies on the Type and Creator data to know what application to launch when the 
file is double clicked (and which icon to show on screen), whereas the Windows PC 
depends strictly on the 3-character file extension.  Windows cannot create Mac Type and 
Creator tags without additional utilities, but a Mac user can add a Windows style extension 
to their Mac file name by simply typing a full stop (period) and the appropriate three letters.  
Otherwise, you may also find that without PC file extensions on any Mac created PDF 
files, PC users will need to guess at the correct host application for the file.  PCs require a 
third party utility to be able to read media formatted for the Mac’s HFS system (see 
Appendix F for utility links).   

32-bit Windows and Macs both allow long filenames, though the allowable characters 
differ.  Windows will not accept the use of characters \ / : * ? " < > | when used in a file 
name (even 8.3 ones), though you may use a full stop (period) and up to 255 characters; 
note this is reduced to a maximum of  64 under the Joliet CD extension.  Mac names may 
be up to 31 characters long.  16-bit Windows requires 8.3 names.   

Depending on the extensions loaded, Macs can read PC media and ISO 9660 CDs; with 
non-default install extensions some OS version can read Joliet format as well.  However, 
without the ‘resource forks’ of a Mac HFS format, the Mac OS user cannot tell the 
associated application for a file so normal point & click opening of files does not work, 
which is confusing for inexperienced users.  Also, without the resource forks, it is 
impossible to include a Mac executable program, so you cannot include either the Mac 
installer or a self-running executable directly. You can include a SIT archive of the installer, 
and presume the user has StuffIt Expander (free software, from www.aladdinsys.com) or 
ask them to download the utility.  

Use the diagram on the next page to help you decide the format of CD your project will 
require. 
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Format compatibility table 

As a Windows based user, you may not be able to create a true Hybrid CD on your PC 
such as that described by Adobe in Appendix A, but careful choice of format will certainly 
allow you to offer any Mac users access to the PDFs.  Using ISO 9660 format, they will 
not see a file with an Acrobat file icon, but if they have Mac Acrobat/Reader installed on 
their system they can use it to open the PDFs.  Not ideal, but better than no file at all. 

You will see from the table below, there is no ideal solution and you need to consider your 
intended users equipment before selecting a format and any constraints that it imposes on 
you.  

 PC Mac 

Format: Read/see 
files? 

Needs extra 
tools to make? 

Read/see 
files? 

Can see correct 
application icons? 

ISO 9660 Level 1 Yes No Yes No 

ISO 9660 Level 2 
+Joliet 

Yes No Yes short 
names 
seen, 
FILNA~1.T
XT ‡ 

No  

Mac HFS No Yes Yes Yes 

Hybrid Yes Yes Yes Yes 

‡  If Joliet extension to be installed, full name can be read. 

 

ISO 9660 Format 

The ISO 9660 format in its basic form will allow some cross-platform compatibility.  There 
are a number of annoying constraints but without access to a Mac for development, it will 
allow you to author content such as PDFs which Mac users can access without a 
conversion program. 

In ISO 9660 Level 1 (the lowest common denominator, developed with DOS file naming 
limitations in mind):  

n A filename may not contain more than eight ‘d-characters’ which are the capitals 
A to Z, digits 0 to 9, and the underscore symbol ( _ ).  The full stop/period (.) 
character is used to separate the filename from the extension but may not be 
used in the filename, e.g. " FILE_012.PDF ".  Lower case letters may not be used 
in either the file name or extension. 

n A filename extension may not contain more than three d-characters.  
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n A directory name may not contain more than eight d-characters and may not 
have an extension, e.g. \MYFOLDER\  not \AllMyFold.ers\ 

n Folders may not be nested to a depth of more than 8 levels, i.e. root folder + 7.  

Minimum equipment needed to produce this format: 

n 32-bit Windows PC or Mac 

n CD-R drive (preferably SCSI) 

n CD-R authoring software 

n 700 Mb free, hard disk space for disk image 

 

ISO 9660 Level 2 and Joliet Format 

The ISO 9660 Level 2 standard removes the naming constraints of strict ISO 9660 Level 1 
but is not compatible with MS-DOS or DOS compatible systems (e.g. basic Mac 
extensions for reading PC media).   

Joliet is an extension of the ISO 9660 standard, developed by Microsoft to allow CDs to be 
recorded using long filenames, and using the Unicode international character set. Joliet 
allows you to use filenames up to 64 characters in length, including spaces.  Under this 
format a copy of the MS-DOS 8.3 file names is stored to allow other systems that can read 
8.3 files. 

The combination of ISO 9660 + Joliet is the sensible option for a cross-platform if 
equipment precludes the production of true hybrid CDs.  Note that Joliet only allows 64 
character names - as opposed to the 255 characters allowed by 32-bit Windows. 

With this format, Mac users will be able to read the CD but will only see Windows short file 
names - for “ReadThisFile.txt” they will see “Readth~1.txt”.  In this situation you should 
consider restricting yourself to 8.3 filenames to assist all users.  There is a Mac extension 
that supports the Joliet format but it is not a default install and in not found in early versions 
of the Mac OS.   If you need wide Mac compatibility it is best not to rely on the presence of 
this extension. 

If you wish to include Mac files such as executables you should consider creating Hybrid 
CDs.  

Minimum PC equipment needed to produce this format: 

n 32-bit Windows PC or Mac 

n CD-R drive (preferably SCSI) 

n CD-R authoring software 

n 700 Mb free, hard disk space for disk image 



 

 21 

. . . . . . . . . 
 

 

Mac HFS Format 

This is the Mac’s native system and a Mac only format.  Without add-on (non-Microsoft) 
utilities your PC won’t even be able to read the CD.  With such utilities you will be able to 
create an HFS CD though you may require a Mac to create the content.  Your PC will 
require either a hard disk (or partition thereof) that is Mac formatted or fast (SCSI) Mac 
removable drives.  

It is more likely as a PC based user that you will use HFS format indirectly in the context of 
making a Hybrid CD. 

Minimum equipment needed to produce an HFS-only CD: 

n 32-bit Windows PC or a Mac 

n CD-R drive (preferably SCSI) 

n Utilities to allow handling of Mac media by PCs 

n CD-R authoring software capable of writing HFS format (only a few applications) 

n Cross-platform transfer media to move Mac media to PC or vice versa. 

n 700 Mb free, hard disk space for disk image 

 

Hybrid CD Format (for both PC & Mac) 

The format combines an ISO 9660 element for PCs and an HFS element for Macs.  This 
is achieved either by putting 2 sets of data on the CD, or in the higher-end applications, 
certain data is common to both file systems - e.g. cross-platform formats such as PDF files 
but OS specific partitions for executable files.  This sharing of data offers a potential saving 
of space for more content storage. 

PC applications to burn hybrid CDs are just becoming available, though they tend to use 
the twin partition system.  Unless you need more than 325 Mb (half the total 650 Mb) this 
should not be a concern. 

More tiresome is getting the getting the Mac media on to or accessible from your PC.  In 
the section on setting up your CD, I mention several suitable utilities you will need for this 
task. 

Should you be working on a Mac, with Adaptec’s Toast, you will need to remember to 
choose the format of the non-Mac partition.  If you need long names, you are best advised 
to select ISO9660+Joliet. 

Minimum equipment needed to produce an HFS-only CD: 

n 32-bit Windows PC or Mac 
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n CD-R drive (preferably SCSI)  

n Utilities to allow handling of Mac media by PCs 

n CD-R authoring software capable of writing HFS format (only a few applications) 

n 700 Mb free, hard disk space for disk image 

 

Using Reader v4 files and ISO 9660 Level 1 

If you look at Appendix C you will see certain folder/file names in bold.  These are potential 
problems under ISO 9660 — especially if you use the most restrictive (Level 1) 
implementation. 

The \Acrobat 4.0\ folder is not a problem, as Reader seems happy to run from a 
folder \ACROBAT4\ —— or anything else, I'd say from testing.  Note that the \help\ and 
\resource\ (font) folders are placed at the same folder ‘level’ as \reader\ though the 
name of the containing folder appears not to need to be \Acrobat 4.0\.  It appears 
that as long as you get Acrord32.exe started from ..\wherever\reader\ it'll be happy, 
so long as the folder structure below the starting folder is what it expects and the \help\ 
and \resource\ folders are co-located with it. 

If you use automatic ISO 9660 Level 1 naming in your CD-R software, the default top level 
folder can get truncated to \ACROBAT_\.  Although Reader will run from this folder, 
AutoPlaying from this location fails - it appears the trailing underscore in the path causes a 
failure when parsing the path; click the ‘open’ command in Reader and the dialog opens at 
..\ACROBAT_\ and not \READER\ as expected.  If using strict ISO 9660 Level 1 then 
change the top level folder to \ACROBAT4\. 

The copyright file (..\reader\(c)adobe.txt) is problematic, as under the licence it is 
a file required for inclusion yet it is not ISO9660 naming compliant.  The closest compliant 
name match is _C_ADOBE.TXT.  In testing, it became apparent that in presenting the 
EULA on first use Reader either accepts this file name as a source or EULA text used to 
create the EULA acceptance dialog text the user sees is stored elsewhere in the 
application files. 

The \JavaScripts\ folder name is more problematic, as this is 10 characters long.  
Interestingly, the pre-installed Reader on the Acrobat CD has the 2 JavaScript plug-in files 
located one level up in the containing \reader\acroform\ folder.  The Forms 
JavaScript Guide (link requires full Acrobat) says: 

Plug-in folder level 

JavaScript’s can work as individual files with the “.js” extension. The Acrobat Forms 
plug-in looks for these files on the UNIX platform in the Acrobat plug-ins folder. On 
the Apple Macintosh and Windows platforms, the files are in a subfolder of the 
\plug_ins\Acroform\ folder called JavaScripts. Variables and functions that might be 
generally useful to the application should be kept at the plug-in level. 
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By that logic, the layout of the ‘installed’ Reader on the Acrobat v4 application CD is 
incorrect.  Though not tested, I assume that if you use the reduced file set (Appendix C) 
then you should recreate the file layout of the relevant folders on the Acrobat CD 
(Appendix B), i.e. place the contents of the \JavaScripts\ folder in the \Acrofrom\ folder and 
delete the \JavaScripts\ folder.  If you are not using JavaScript in any of the PDFs on the 
CD and need Level 1 format I suspect you could also choose omit this folder altogether, 
removing JavaScript functionality, though by the strict terms of the licence it should be 
included.   

In summary, I do not generally recommend trying to use strict ISO 9660 Level 1 format — 
or certainly not for anything other than internal use.  However, you may need to access 
the CD’s files from Windows 3.x or MS-DOS, though Reader v3x 16-bit is required for 
Windows 3.x to actually open PDFs).  The reason for describing a method that does not 
seem to work will hopefully save others the time and trouble of testing it themselves.   

ISO 9660 Level 2 with Joliet extensions is generally a better choice for the PC, as you do 
not need to do so much renaming.  Frustratingly, ISO 9660 Level 2 is not fully compatible 
with 16-bit Windows so if you still want your CD to be accessible to Windows 3x users, 
you need to consider Level 1 and restrict yourself to 8.3 names. 

 

Setting up your CD image files 

Image File Names.  

Many CD creation programs make ‘.ISO’ files as source images for burning CD-Rs.  While 
standards were still evolving the ISO extension became synonymous with image files in 
general and not just disc image files conforming to the ISO standard.  Thus the presence 
of an ISO file extension does not necessarily mean that your CD image file is in ISO 
format.  Irksome as it may be, don’t just rely on the application's ‘wizard’ but check out the 
help file and program properties to ensure you are creating a CD of the type you intended.   

Image Files 

Depending on the size and speed of your systems you have number of options.  If your 
system is fast enough, you can probably burn “on the fly” using files from anywhere on 
your system.  More likely you will organise the needed files in one place on your system 
as an image and/or actually create an ISO image file (necessary for some techniques) to 
burn from.  The term staging drive or folders is sometimes used to imply the area where 
you bring all your CD's files together. 

Don’t forget to ensure the partitions used for your source files have been de-fragmented 
recently to ensure best hard disk file access speeds. 

Single or Multisession? 

Note that many CD making applications assume as the default that you wish to make a 
multi-session disk and leave the CD ‘open’ to allow you to add more data in another 
session at a later date.  Multi-session disks increases the chance of reading problems in 
‘normal’ CD- and DVD-ROM drives.  Therefore, you are advised to check the option to 
‘close’ the CD before burning.  The location and naming of this varies from CD application 
to application. Unfortunately you are likely have to set this option every time you burn a 
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CD, until CD creating apps get smarter.  This reinforces the need to check settings and 
not rely on easy-to-use 'wizards' which tend to apply the default settings.  

My users can’t read my CDs (at all) 

Assuming your files all worked fine in test before burning, then if a large number fail on 
distribution try the CD-write drive out using a different brand of CD-R blanks.  To avoid this 
situation, if you have access to a number of different types of user PC/Mac, it is worthwhile 
doing a small-scale test before replicating for your whole audience. 

If a very small number fail and only on some PCs you may have encountered the 
annoyance that some combinations of CD-writer, CD dye type and user hard drive just 
don’t mix.  If you have more than one CD-R drive try using it and also try different 
media/drive combinations.  If you have a fast CD-R drive and normally burn at fastest 
speed, try using a slower setting.  If feasible, ask the user to try using a different PC — this 
can help identify ‘bad’ CD writer/CD media/CD reader combinations.  One of these actions 
should provide the user with the right experience. 

You can probably avoid these sort of problems by passing off the work to a professional 
replicating house, but then if you could (afford to) do that easily, you don’t really need this 
document. 

Labelling CDs 

Don’t forget that the data layer of a recordable CD is actually the top (label side); scratch 
the top and your data could be damaged.  So, if you are going to write on the CDs, do get 
a marker designed for this purpose.  For larger runs, you can by label kits that allow you to 
print up label blanks on an inkjet and apply these by hand.  Any further requirement in 
volume/speed and you should look to external professional services as the equipment 
begins to become too expensive to justify purchase for limited, low volume use. 

AutoPlay 

If the CD can be read in Windows Explorer but does not AutoPlay, check that this feature 
has not been turned off on the target PC.  For instructions on how to turn the feature 
on/off, open Windows Help from the start bar and look in the index under “automatically 
playing CDs when inserted”.  See also the earlier notes on enabling AutoPlay. 

 

PC utilities for handling Mac media 

Remember, if your project requires you to support Mac users, and if it is unacceptable for 
them not to be able to see the ‘correct’ icons on screen, you will have to consider using the 
Hybrid format.  In which case, you are advised to set aside a little extra time to familiarise 
yourself with the process and the extra tools needed.  

To read Mac media (floppy, CD, ZIP, Jazz and network) try: 

n MacOpener  

n MacScuzzy 
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To create virtual Mac partitions on PC hard drives: 

n MacImage 

To burn CDs with HFS or Hybrid format 

n Nero.  Can burn a twin partition hybrid with SCSI access to Mac media or via an 
ISO file using MacImage 

n WinOnCD.  Can burn HFS and hybrid.  (Not tested). 

n (Using MacImage to create a virtual partition) Any CD burning application 
supporting the ISO format - e.g. Easy CD Creator Deluxe. 

A more radical approach is to consider a cheap or used Macintosh.  It will, with the right 
software applications such as Adaptec’s Toast, make burning the CD much easier.  More 
than that, without a Mac you are in an almost impossible situation when dealing with 
technical support issues.  Of course, this method only works if you know a bit about Macs 
in the first place or you will need the very support you are trying to provide.  Remember 
that if you have an external SCSI CD-writer you can use it with either Macs or PCs. 
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Compatibility and other issues 

 

What happens if the user has a different version of Acrobat installed on their 
system? 

If you run Reader v4 from the CD you should not have problem, even if older versions of 
Reader or Acrobat Exchange are on the users system. 

Installed Acrobat Elements  Effects of running v4.0 Reader from CD 
Reader not installed  EULA for v4 displayed.  Reader v4 writes to Registry.   

Does not create PDF extension association to Acrobat Reader. 
Reader v2.x   EULA for v4 displayed.  Reader v4 writes to Registry.   

INI for installed version not affected. 
PDF extension association to v2.x unaffected. 

Reader v3.x  EULA for v4 displayed.  Reader v4 writes to Registry. 
INI for installed version not affected. 
PDF extension association to v3.x unaffected. 

Reader v4.0  MRU file list updated. 
Registry keys for Reader's interface settings updated 
PDF extension remains registered to h/d installed version. 

Acrobat v4.0 (no Reader)*  EULA for v4 displayed.  Reader v4 writes to Registry. 
Some Registry keys for viewer interface settings updated 
PDF extension association unaffected. 

Acrobat v4.0 (with Reader)  Reader MRU file list updated. 
Registry keys for viewer interface settings updated 
PDF extension association unaffected. 

 

Notes: 

1) The EULA (End User License Agreement) is the text contained in the 
“(C)Adobe.txt” file in the \Reader\ folder of Reader and its display is a required part 
of the licence conditions.  It will only display the first time Reader is run on a ‘new’ 
system.  If you need to reset this EULA flag for testing purposes, you will find it at:  

HKEY_CURRENT_USER\Software\Adobe\Acrobat Reader\4.0\AdobeViewer\EULA 

2) When first run, Reader v4.0 writes a number of keys to the Windows 95/98 Registry 
at: 

HKEY_CURRENT_USER\Software\Adobe\Acrobat\ 

  and  

HKEY_CURRENT_USER\Software\Adobe\Acrobat Reader\ 
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3) If Reader v4 is already on the user’s system, the CD version will write to the same 
Registry strings as the hard disk copy, so changes to the Reader toolbars and the 
MRU (Most Recently Used) file list will get updated by the Reader copy most recently 
used. 

4) Though Reader v4 writes to your Windows Registry, it does not change existing 
associations for the PDF file extension.  So if you have Reader 3.0x installed on the 
hard drive and associated with PDFs, double clicking on a PDF on the hard-drives or 
CD will open v3.0x of Reader and not v4, as it stores its preferences in 
C:\Windows\acroread.ini and not the Registry. 

5) All v4.x Acrobat components - Acrobat, Reader, Browser plug-in - on a given PC use 
a common viewer and set of preferences, regardless of being installed or run from 
CD.  If Reader is run from CD, changes made to preferences will be retained when 
the hard disk versions are next run. 

 

What happens if I install Reader v4 over a previous older version? 

It is conceivable that for functionality testing you might want to have both v3.0x and v4 
installed on the same PC and this is possible. 

If you run the v4 installer and it detects a previous version of the application, it gives this 
warning message: 

Warning 

Acrobat 3.0x currently exists on your system.  Problems will occur if 3.0 is uninstalled after 4.0 
is installed.  This would require 4.0 to be reinstalled. 

If you choose to uninstall Acrobat 3.0x, please do so and restart your computer before 
installing Acrobat 4.0 

[Note:  you also get this with Exchange v3 but no Reader v3 installed.] 

The warning is correct; v4 of Reader will co-exist happily with older version but if your 
subsequently remove the older versions you will need to re-install v4.  Thus you should 
ensure you have a copy of the installer handy, especially if the user does not have easy 
Internet access to the Adobe web site. 

If your user base still makes use of Reader v3, it would be courteous to put the Reader v3 
installer somewhere on the CD as well, giving the option as to what they install. 

I have not tested configurations using third party plug-ins.  If you know your intended 
audience is using these, I recommend you do some further test of your own to seethe 
effects of having v3 and v4 Acrobat Reader apps on your hard drive.  Given how plug-ins 
work there ought not to be a problem, though a test is the safest route. 
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Likewise, using v3 and v4 Reader on the same PC may result in the ‘wrong’ app acting as 
the web browser associated plug-in.  You may need to provide guidance to your users on 
how to fix this if it is a likely issue. 

If upgrading from v4x to a more recent v4x  (e.g. v4.0 to v4.05c) uninstall the old version 
before installing the newer one. 

 

Does Reader have to be in the \Program Files\Acrobat 4.0\ folder on my CD? 

No.  As long as the \Resource\ and \Help\ folders are in the same folder as 
\Reader\ the number and naming of the folders lying above are not important - unless 
you require ISO 9660 Level 1 naming.  Of the folders within \Reader\, the \Optional\ 
folder is just that and may be deleted.  Also, it appears that the \JavaScripts\ folder 
(note the file name is 10 characters long) in \Reader\plug_ins\AcroForm\ can be 
omitted if the files contained in it are moved up in to the \AcroForm\ folder above. 

If the default \Acrobat 4.0\ folder name is shortened to DOS/ISO 9660 compliant 
\ACROBAT_\ the app will run but Windows may experience problems parsing command 
lines - such as in the autorun.ini - due to the trailing underscore character.  Tests using the 
path \Acrobat\Reader\etc. have shown no problems. 

If you do have to shorten the folder name, \ACROBAT4\ is both ISO 9660 Level 1 
compliant and self-evident as the application and version. 

 

What plug-ins can I use with Reader on the CD? 

If your project depends on anything other than the default set of plug-ins installed by 
Reader, you should check early on with the vendor/programmer as to whether they will 
work in Reader (and are so licensed) and will function from a CD.  Most Acrobat plug-ins 
require the full paid-for application to work.  Plug-in functionality is deliberately more 
restricted in the free Reader. 

Note the comments in the Adobe tech note (Appendix A) about functions not supported 
when Reader is running from CD, as the same is likely to apply here. 

 

Can I run Reader v4 across a network? 

Though not documented, advised or supported, this does appear possible.  Simple Tests 
have shown a shared CD drive on a Win 9x network able to support two concurrent 
sessions on different PCs ‘run’ from the CD on a third.   Note the only PDFs tested were 
simple documents that do not use plug-ins or complex functionality.  This experience does 
make sense if you think of the source PC's hard drive as acting like a shared CD drive. 

It is likely that more complicated PDFs using plug-ins may fail, depending on where the 
local session ‘looks’ for the plug-in or associated records. In general, it appears that so 
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long as Reader finds the folders it's looking for below the folder it's run from, then all 
should be well. 

Note the comments in the Adobe tech note (Appendix A) about functions not supported 
when Reader is running from CD, as the same is likely to apply here. 

This feature is mentioned for interest only. 

Can I run more than one instance of Reader on my PC? 

No.  Acrobat runs as a single instance application.  In fact Acrobat, Reader and the 
browser plug-in share a common 'viewer'.  Opening Acrobat when Reader is open will 
cause the reader window to gain focus (displaying any PDF called).  The reverse is true if 
Acrobat is open first.  If Acrobat or reader is open and the browser plug-in is invoked, 
either the main app or the plug-in may crash or freeze, based on experience. 

 

Can I run the browser plug-in from the CD? 

No.  The plug-in is designed for use on the hard disk either linked to or installed with the 
browser files.  Mainstream browsers do not run from CD. 

 

Can I control Reader from other applications? 

Yes, you should download and read the Acrobat SDK, especially the section on IAC (Inter 
Application Communication).  Note that Adobe have deliberately designed less 
functionality into Reader than the full application so you may find you requite the user to 
have the full application. 

Note that the ActiveX control (pdf.ocx) and Type Library (pdf.tlb) are intended by Adobe 
only for use as a browser plug-in and not as a control for use in other applications.  You 
will not find documentation on its object model in the SDK as it is not intended for 
development use.  The acrobat.tlb Library requires the full application for use, not Reader. 

Reader v4 command line options  

Reader has more limited options for external control than Acrobat, primarily a small 
number of command line options.  The following is taken from the Acrobat SDK in the 
section “Using Command Lines with Acrobat and Acrobat Reader under Windows”. 

These are unsupported command lines, but have worked for some developers. 
There is no documentation for these commands other than that listed below. You 
can display and print a PDF file using command lines with Acrobat and Acrobat 
Reader. 

AcroRd32.exe filename - Executes the Reader and displays a file. 

AcroRd32.exe /p filename - Executes the Reader and prints a file. 
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AcroRd32.exe /t path printername drivername portname - Initiates Acrobat Reader, 
prints a file while suppressing the Acrobat print dialog box, then terminates Reader.  
The four parameters of the /t option evaluate to path, printername, drivername, and 
portname (all strings): 

printername - The name of your printer. 

drivername - Your printer driver's name. Whatever appears in the Driver Used box 
when you view your printer's properties. 

portname - The printer's port. portname cannot contain any "/" characters; if it does, 
output is routed to the default port for that printer. 

If using Acrobat, substitute Acrobat.exe in place of AcroRd32.exe in the command 
lines. 
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Appendix A - Adobe Technical Support Documentation on Creating a 
CD to Distribute Acrobat Reader (#323115) 

 

What's Covered 

n Copying Acrobat Reader to Run from a CD 

n Copying Acrobat Reader to Install from a CD 
 

Adobe Acrobat Reader 4.0 is freely distributable. Acrobat 4.0 includes two versions of 
Acrobat Reader 4.0 that you can distribute via CD or other means, such as e-mail or the 
Web. One version can be run from a CD without having to install it on a local hard disk. 
This version includes Asian font support.  The other version is an Acrobat Reader 4.0 
installer, which you can use to install Acrobat Reader to a local hard disk. This installed 
version does not include Asian font support. 

Disclaimer: This document provides an overview of which files to copy onto the CD you're 
creating. Adobe provides this information as a courtesy. Adobe Technical Support does 
not support creating CDs or setting up a staging area. (The staging area is the folder or 
disk to copy onto the CD). If you need assistance creating CDs or setting up a staging 
area, refer to the documentation included with your CD writer. 

Note: If you will be distributing your CD to Mac OS users, you must create it in Mac OS. If 
you create the CD in Mac OS, you can add both Mac OS and Windows files to it — both 
Mac OS and Windows will be able to recognise the files. If you create the CD in Windows, 
you may be able to add both Mac OS and Windows files to the CD, but Mac OS will not 
recognise the Mac OS files. 

 

Copying Acrobat Reader to Run from a CD 

Use this method to distribute a version of Acrobat Reader that runs from a CD without 
having to be installed. 

Note that when Acrobat Reader is run from the CD, rather than from a copy installed on a 
local hard disk, Acrobat Reader's support files are not installed on the local hard disk. 
Therefore, the following features are missing or do not work: -  

n Adobe Online will not work. 

n OLE viewing will not work: If you double-click an embedded PDF file, nothing 
happens. 

n PDF files will not be associated with Acrobat Reader. Therefore, PDF files won't 
automatically open in Acrobat Reader if you double-click them. You must choose File 
> Open in Acrobat Reader and select the file you want to open. 
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Browser windows will not display PDF files, because the Web browser plug-ins and 
ActiveX control are not installed. (The Web browser plug-ins enable Netscape Navigator 
for Mac OS and Windows or Microsoft Internet Explorer for Mac OS to display PDF files. 
The ActiveX Control enables Internet Explorer for Windows to display PDF files). To view 
PDF files outside of a Web browser, download them to your hard disk and then open them 
in Acrobat Reader.  
  
To create a CD from which you can run Acrobat Reader 4.0, copy the Acrobat Reader 
from the Acrobat 4.0 CD to your staging area, and then create a shortcut or alias to the 
Acrobat Reader application file: 

1. Do either of the following: 

n From the Acrobat 4.0 for Windows CD-ROM, copy the CD folder from the 
Acroread folder to your staging area.  Files are listed at Appendix B. 

n From the Acrobat 4.0 for Mac OS CD-ROM, copy the CD folder from the Acrobat 
Reader 4.0 folder to your staging area.  

2. Do either of the following: 

n (Windows) Create a shortcut to the Acrord32.exe file in the CD\Reader folder in 
your staging area.  

n (Mac OS) Create an alias for the Acrobat Reader 4.0 file in the CD\Acrobat 
\Reader 4.0 folder in your staging area.  

3. Move the shortcut or alias you created in step 2 to the root of the staging area.  

4. Create the CD from your staging area as usual. 

 

Running Acrobat Reader from a CD 

To run the version of Acrobat Reader 4.0 from the CD, double-click the shortcut or alias 
you created above. You can also double-click the Acrord32.exe file in the CD\Reader 
folder (Windows) or the Acrobat Reader 4.0 file in the CD:Acrobat Reader 4.0 folder (Mac 
OS). 

 

Copying Acrobat Reader to Install from a CD 

Use this method to distribute a version of Acrobat Reader that can be installed from the 
CD. Note that Acrobat Reader's Asian font packs do not install, so you will not be able to 
view PDF files containing non-embedded Asian-language fonts. 
  
To copy Acrobat Reader 4.0 to a CD from which it can be installed, copy the installer from 
the Acrobat 4.0 CD to your staging area, and then create a shortcut or alias to the Acrobat 
Reader installer: 

1. Do either of the following: 
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n From the Acrobat 4.0 for Windows CD-ROM, copy the Installers folder from the 
Acroread folder to your staging area.  

n From the Acrobat 4.0 for Mac OS CD-ROM, copy the Installers folder from the 
Acrobat Reader 4.0 folder to your staging area.  

2. Do either of the following: 

n (Windows) Create a shortcut to the Acrd4enu.exe file in the Installers folder in 
your staging area.  

n (Mac OS) Create an alias for the Reader Installer file in the Installers folder in your 
staging area.  

3. Do either of the following: 

n Move the shortcut to the Acrd4enu.exe file you created in step 2 to the root of the 
staging area. 

n Move the alias for the Installers folder you created in step 2 to the CD folder in the 
staging area. (If you haven't added the CD folder to your staging area, as 
described in the "Copying Acrobat Reader to Run from a CD" section above, 
you'll need to create a CD folder at the root of the staging area to contain this 
alias.) 

4. Create the CD from your staging area as usual. 

 

 

[End of Article] 
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Appendix B - File listing for \AcroRead\CD folder of Acrobat v4 CD 

Files for inclusion as recommended in Tech Note # 323115 

The file set listed below will occupy approximately 63.4 Mb + 16.3 Mb for the Reader 
installers (5.3 Mb for only the English version).  Total = approximately 80 Mb.  Note this 
represents over 12% of the 650 Mb available on a normal CD-ROM 

Note also that the Reader installers included on the Acrobat CD (as at mid 1999) are the 
initial release of Reader without the search facility.  For comparison the English version 
with Search is 1 Mb bigger and called rs40eng.exe instead of acrd4enu.exe. If you need 
the versions with Search and they are not on your Acrobat CD, you will need to download 
them from Adobe's website (www.adobe.com) or get the Reader CD-ROM. 

 

Name (and Size for files only) 

[CD]:\Acrobat4\AcroRead 
            \CD  
               License.txt 6,019 
                  \HELP  
                        \DEU  
                           ACROBAT.PDF 62,436 
                           READER.PDF 454,333 
                        \ENU  
                           ACROBAT.PDF 45,836 
                           READER.PDF 304,642 
                        \FRA  
                           ACROBAT.PDF 63,724 
                           READER.PDF 457,883 
                  \READER  
                     ACROFX32.DLL 26,624 
                     ACROJS32.DLL 155,136 
                     ACRORD32.EXE 2,316,288 
                     ADMUI316.FON 15,936 
                     AdobeBanner.awe 9 
                     AdobeBannerdeu.gif 1,100 
                     AdobeBannerenu.gif 1,100 
                     AdobeBannerfra.gif 1,100 
                     ADOBEFNT.LST 23 
                     ADOBEWEB.DLL 212,992 
                     AdobeWeb10.awe 3,122 
                     AdobeWeb10deu.gif 25,741 
                     AdobeWeb10enu.gif 21,693 
                     AdobeWeb10fra.gif 25,367 
                     AGM.DLL 582,144 
                     COOLTYPE.DLL 894,464 
                     LIESMICH.PDF 18,426 
                     LISEZMOI.PDF 16,487 
                     MFC42.DLL 954,640 
                     MSVCRT.DLL 277,776 
                     OLEAUT32.DLL 491,792 
                     RDLANG32.DEU 327,680 



APPENDIX B 

 B-2 
 

                     RDLANG32.FRA 327,680 
                     README.PDF 22,099 
                        \ACTIVEX  
                           PDF.DEU 14,848 
                           PDF.FRA 14,848 
                           PDF.OCX 125,712 
                           PDF.TLB 3,860 
                        \BROWSER  
                           NPPDF32.DEU 4,096 
                           NPPDF32.DLL 51,712 
                           NPPDF32.FRA 4,096 
                        \OPTIONAL  
                           README.TXT 46 
                        \PLUG_INS  
                           AHLS32.API 61,952 
                           AHLS32.DEU 6,144 
                           AHLS32.FRA 6,144 
                           EWH32.API 54,272 
                           EWH32.DEU 9,728 
                           EWH32.FRA 9,216 
                           IEWEB32.API 6,144 
                           WEBLNK32.API 73,728 
                           WEBLNK32.DEU 22,528 
                           WEBLNK32.FRA 21,504 
                              \ACROFORM  
                                 AFILL32.API 402,432 
                                 AFILL32.DEU 92,160 
                                 AFILL32.FRA 92,160 
                                 AFORM.JS  33,257 
                                 AFSTRDEU.JS 4,690 
                                 AFSTRENU.JS 2,104 
                                 AFSTRFRA.JS 4,779 
                              \MOVIE  
                                 MOVIE32.API 111,104 
                                 MOVIE32.DEU 15,872 
                                 MOVIE32.FRA 15,872 
                                 QT2.DLL 7,680 
                                 QT3.DLL 16,384 
                  \RESOURCE  
                        \CIDFont  
                           HeiseiKakuGo-W5-Acro 2,138,544 
                           HeiseiMin-W3-Acro 3,185,156 
                           HYGoThic-Medium-Acro 4,119,292 
                           HYSMyeongJo-Medium-Acro 8,317,064 
                           MHei-Medium-Acro 4,637,712 
                           MSung-Light-Acro 6,665,200 
                           STSong-Light-Acro 11,341,944 
                        \CMAP  
                           83pv-RKSJ-H 6,211 
                           90ms-RKSJ-H 5,146 
                           90ms-RKSJ-UCS2 160,785 
                           90ms-RKSJ-V 3,202 
                           90msp-RKSJ-H 5,075 
                           90msp-RKSJ-V 3,184 
                           90pv-RKSJ-H 6,987 
                           90pv-RKSJ-UCS2 2,165 
                           90pv-RKSJ-UCS2C 147,030 
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                           Add-RKSJ-H 14,593 
                           Add-RKSJ-V 2,775 
                           Adobe-CNS1-B5pc 8,266 
                           Adobe-CNS1-ETen-B5 8,686 
                           Adobe-CNS1-H-CID 1,863 
                           Adobe-CNS1-H-Host 8,701 
                           Adobe-CNS1-H-Mac 8,232 
                           Adobe-CNS1-UCS2 286,858 
                           Adobe-GB1-GBK-EUC 94,141 
                           Adobe-GB1-GBpc-EUC 4,537 
                           Adobe-GB1-H-CID 1,982 
                           Adobe-GB1-H-Host 94,650 
                           Adobe-GB1-H-Mac 4,419 
                           Adobe-GB1-UCS2 303,595 
                           Adobe-Japan1-90ms-RKSJ 6,664 
                           Adobe-Japan1-90pv-RKSJ 8,753 
                           Adobe-Japan1-H-CID 2,101 
                           Adobe-Japan1-H-Host 7,622 
                           Adobe-Japan1-H-Mac 7,641 
                           Adobe-Japan1-PS-H 23,289 
                           Adobe-Japan1-PS-V 13,657 
                           Adobe-Japan1-UCS2 170,429 
                           Adobe-Korea1-H-CID 1,912 
                           Adobe-Korea1-H-Host 16,277 
                           Adobe-Korea1-H-Mac 11,640 
                           Adobe-Korea1-KSCms-UHC 16,169 
                           Adobe-Korea1-KSCpc-EUC 11,818 
                           Adobe-Korea1-UCS2 203,656 
                           B5pc-h 6,701 
                           B5pc-UCS2 1,536 
                           B5pc-UCS2C 284,917 
                           B5pc-v 1,843 
                           CNS-EUC-H 11,553 
                           CNS-EUC-V 12,633 
                           ETen-B5-H 6,863 
                           ETen-B5-UCS2 288,774 
                           ETen-B5-V 1,882 
                           ETenms-B5-H 1,514 
                           ETenms-B5-V 1,941 
                           Euc-h 4,099 
                           Euc-v 2,145 
                           Ext-RKSJ-H 15,192 
                           Ext-RKSJ-V 2,415 
                           Gb-euc-h 3,419 
                           Gb-euc-v 2,017 
                           GBK-EUC-H 86,194 
                           GBK-EUC-UCS2 233,863 
                           GBK-EUC-V 2,003 
                           GBpc-EUC-H 3,449 
                           GBpc-EUC-UCS2 1,623 
                           GBpc-EUC-UCS2C 148,429 
                           GBpc-EUC-V 2,029 
                           GBT-EUC-H 48,022 
                           GBT-EUC-V 2,023 
                           H 3,958 
                           Identity-H 1,614 
                           Identity-V 1,527 
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                           KSC-EUC-H 11,109 
                           KSC-EUC-V 1,949 
                           KSCms-UHC-H 15,533 
                           KSCms-UHC-HW-H 15,528 
                           KSCms-UHC-HW-V 1,959 
                           KSCms-UHC-UCS2 190,158 
                           KSCms-UHC-V 1,961 
                           KSCpc-EUC-H 11,982 
                           KSCpc-EUC-UCS2 16,639 
                           KSCpc-EUC-UCS2C 157,136 
                           UCS2-90ms-RKSJ 155,710 
                           UCS2-90pv-RKSJ 148,630 
                           UCS2-B5pc 285,242 
                           UCS2-ETen-B5 299,470 
                           UCS2-GBK-EUC 244,146 
                           UCS2-GBpc-EUC 197,474 
                           UCS2-KSCms-UHC 196,760 
                           UCS2-KSCpc-EUC 153,636 
                           UniCNS-UCS2-H 264,302 
                           UniCNS-UCS2-V 1,878 
                           UniGB-UCS2-H 279,907 
                           UniGB-UCS2-V 2,087 
                           UniJIS-UCS2-H 143,025 
                           UniJIS-UCS2-HW-H 1,720 
                           UniJIS-UCS2-HW-V 4,651 
                           UniJIS-UCS2-V 4,563 
                           UniKS-UCS2-H 173,553 
                           UniKS-UCS2-V 1,988 
                           V 2,121 
                              \CMAP  
                                 Identity-H 1,614 
                                 Identity-V 1,527 
                        \Encoding  
                           Acracns1.dll 55,808 
                           Acragb1.dll 54,272 
                           AcRAJPN1.dll 69,120 
                           Acrakor1.dll 55,296 
                        \FONT  
                           _A______.PFB 32,084 
                           _AB_____.PFB 31,966 
                           _ABI____.PFB 32,019 
                           _AI_____.PFB 32,115 
                           _EB_____.PFB 35,377 
                           _EBI____.PFB 38,543 
                           _EI_____.PFB 37,518 
                           _ER_____.PFB 35,380 
                           COB_____.PFB 35,500 
                           COBO____.PFB 50,532 
                           COM_____.PFB 34,585 
                           COO_____.PFB 48,468 
                           SY______.PFB 34,705 
                           ZD______.PFB 49,593 
                           ZX______.PFB 75,573 
                           ZY______.PFB 96,418 
                              \FONT  
                                 _A______.PFB 32,084 
                                 _AB_____.PFB 31,966 
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                                 _ABI____.PFB 32,019 
                                 _AI_____.PFB 32,115 
                                 _EB_____.PFB 35,377 
                                 _EBI____.PFB 38,543 
                                 _EI_____.PFB 37,518 
                                 _ER_____.PFB 35,380 
                                 COB_____.PFB 35,500 
                                 COBO____.PFB 50,532 
                                 COM_____.PFB 34,585 
                                 COO_____.PFB 48,468 
                                 SY______.PFB 34,705 
                                 ZD______.PFB 49,593 
                                 ZX______.PFB 75,573 
                                 ZY______.PFB 96,418 
                                    \PFM  
                                       _A______.PFM 5,809 
                                       _AB_____.PFM 5,330 
                                       _ABI____.PFM 5,336 
                                       _AI_____.PFM 5,816 
                                       _EB_____.PFM 4,941 
                                       _EBI____.PFM 4,683 
                                       _EI_____.PFM 4,815 
                                       _ER_____.PFM 4,692 
                                       COB_____.PFM 679 
                                       COBO____.PFM 686 
                                       COM_____.PFM 674 
                                       COO_____.PFM 682 
                                       SY______.PFM 672 
                                       ZD______.PFM 684 
                                       ZX______.MMM 7,248 
                                       ZX______.PFM 683 
                                       ZY______.MMM 7,248 
                                       ZY______.PFM 684 
                              \PFM  
                                 _A______.PFM 5,809 
                                 _AB_____.PFM 5,330 
                                 _ABI____.PFM 5,336 
                                 _AI_____.PFM 5,816 
                                 _EB_____.PFM 4,941 
                                 _EBI____.PFM 4,683 
                                 _EI_____.PFM 4,815 
                                 _ER_____.PFM 4,692 
                                 COB_____.PFM 679 
                                 COBO____.PFM 686 
                                 COM_____.PFM 674 
                                 COO_____.PFM 682 
                                 SY______.PFM 672 
                                 ZD______.PFM 684 
                                 ZX______.MMM 7,248 
                                 ZX______.PFM 683 
                                 ZY______.MMM 7,248 
                                 ZY______.PFM 684 
                        \HELP  
                              \ENU  
                                 ACROBAT.PDF 45,836 
                                 READER.PDF 304,642 
                              \FRA  
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                                 ACROBAT.PDF 63,724 
                                 READER.PDF 457,883 
                        \READER  
                           ACROFX32.DLL 26,624 
                           ACROJS32.DLL 155,136 
                           ACRORD32.EXE 2,316,288 
                           ADMUI316.FON 15,936 
                           AdobeBanner.awe 9 
                           AdobeBannerenu.gif 1,100 
                           AdobeBannerfra.gif 1,100 
                           ADOBEFNT.LST 23 
                           ADOBEWEB.DLL 212,992 
                           AdobeWeb10.awe 3,122 
                           AdobeWeb10enu.gif 21,693 
                           AdobeWeb10fra.gif 25,367 
                           AGM.DLL 582,144 
                           COOLTYPE.DLL 894,464 
                           LISEZMOI.PDF 16,487 
                           MFC42.DLL 954,640 
                           MSVCRT.DLL 277,776 
                           OLEAUT32.DLL 491,792 
                           RDLANG32.FRA 327,680 
                              \ACTIVEX  
                                 PDF.FRA 14,848 
                                 PDF.OCX 125,712 
                                 PDF.TLB 3,860 
                              \BROWSER  
                                 NPPDF32.DLL 51,712 
                                 NPPDF32.FRA 4,096 
                              \OPTIONAL  
                                 README.TXT 46 
                              \PLUG_INS  
                                 AHLS32.API 61,952 
                                 AHLS32.FRA 6,144 
                                 EWH32.API 54,272 
                                 EWH32.FRA 9,216 
                                 IEWEB32.API 6,144 
                                 WEBLNK32.API 73,728 
                                 WEBLNK32.FRA 21,504 
                                    \ACROFORM  
                                       AFILL32.API 402,432 
                                       AFILL32.FRA 92,160 
                                       AFORM.JS  33,257 
                                       AFSTRENU.JS 2,104 
                                       AFSTRFRA.JS 4,779 
                                    \MOVIE  
                                       MOVIE32.API 111,104 
                                       MOVIE32.FRA 15,872 
                                       QT2.DLL 7,680 
                                       QT3.DLL 16,384 
                        \RESOURCE  
                              \CMAP  
                                 Identity-H 1,614 
                                 Identity-V 1,527 
                              \FONT  
                                 _A______.PFB 32,084 
                                 _AB_____.PFB 31,966 
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                                 _ABI____.PFB 32,019 
                                 _AI_____.PFB 32,115 
                                 _EB_____.PFB 35,377 
                                 _EBI____.PFB 38,543 
                                 _EI_____.PFB 37,518 
                                 _ER_____.PFB 35,380 
                                 COB_____.PFB 35,500 
                                 COBO____.PFB 50,532 
                                 COM_____.PFB 34,585 
                                 COO_____.PFB 48,468 
                                 SY______.PFB 34,705 
                                 ZD______.PFB 49,593 
                                 ZX______.PFB 75,573 
                                 ZY______.PFB 96,418 
                                    \PFM  
                                       _A______.PFM 5,809 
                                       _AB_____.PFM 5,330 
                                       _ABI____.PFM 5,336 
                                       _AI_____.PFM 5,816 
                                       _EB_____.PFM 4,941 
                                       _EBI____.PFM 4,683 
                                       _EI_____.PFM 4,815 
                                       _ER_____.PFM 4,692 
                                       COB_____.PFM 679 
                                       COBO____.PFM 686 
                                       COM_____.PFM 674 
                                       COO_____.PFM 682 
                                       SY______.PFM 672 
                                       ZD______.PFM 684 
                                       ZX______.MMM 7,248 
                                       ZX______.PFM 683 
                                       ZY______.MMM 7,248 
                                       ZY______.PFM 684 
            \Installers  
               ACRD4DEU.EXE 5,994,880 
               ACRD4ENU.EXE 5,455,526 
               ACRD4FRA.EXE 5,653,836 

       

 

 

 

[End of Listing/Article] 
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Appendix C - Reduced file listing for Reader on CD (for English 
language only users) 

Files for inclusion for Reader on CD to minimise space used.  Only suitable if distribution is 
to English language audience only.  Only English language version of the application, help 
files and installer are included 

The file set listed below will occupy approximately 7.9 Mb.  The English language Reader 
installer is further 6.2 Mb if included, totalling 14 Mb.  Note this represents a 80% space 
saving on the officially described file set 

The files with names including the characters “VDK” are associated with Search and are 
thus not found in the basic version of Reader. 

 

Name (and Size for files only) 

Listing gives folder/file NAME and file SIZE for files only.  Filenames which are still non-
ISO 9660 compliant when in all uppercase are in shown in bold.  Files which are probably 
non-essential to running from CD and which might be omitted are shown in italics (not 
tested by author). 

 
[CD]:\Acrobat 4.0  
      \Help  
             \ENU  
               Acrobat.pdf 45,836  (Flyer for Acrobat) 
               Reader.pdf 415,715  (Reader Help file) 
      \Reader  
         (c)Adobe.txt 6,019    (EULA text) 
         Acrofx32.dll 26,624 
         AcroJs32.dll 155,136 
         AcroRd32.exe 2,316,288   (Reader’s exe file) 
         Admui316.fon 15,936 
         Agm.dll  582,144 
         Cooltype.dll 894,464 
         ReadMe.pdf 83,513   (Reader ‘Read Me’) 
         VDK150.DLL 878,592   (Search version file) 
         VDK150a.dll 8,192    (Search version file) 
            \ActiveX  
               pdf.ocx 125,712 
               PDF.tlb 3,860 
            \browser  
               nppdf32.dll 51,712  (Browser plug-in) 
            \Optional     (optional spare folder) 
               Readme.txt 46 
            \plug_ins  
               Ahls32.api 61,952 
               asrch32.api 186,368  (Search version file) 
               autidx32.api 28,672  (Search version file) 
               EWH32.api 54,272 
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               ieweb32.api 6,144 
               weblnk32.api 73,728 
                  \AcroForm  
                     Afill32.api 402,432 
                        \JavaScripts  
                           Aform.js  33,257 
                           Afstrenu.js 2,104 
                  \Movie  
                     Movie32.api 111,104 
                     QT2.dll  7,680 
                     QT3.dll  16,384 
                  \vdkhome    (Search version file) 
                     VDK10.CMP 4,044  (Search version file) 
                     VDK10.LIC 41  (Search version file) 
                     VDK10.STD 2,070  (Search version file) 
                     VDK10.SYX 415  (Search version file) 
                     VDK10.THD 304  (Search version file) 
                        \ENU      (Search version file) 
                           VDK10.LNG 23,283  (Search version file) 
                           VDK10.RSD 61,440  (Search version file) 
                           VDK10.RST 2,359   (Search version file) 
                           VDK10.STC 15,103  (Search version file) 
                           VDK10.STP 3,141   (Search version file) 
                           VDK10.SYD 806,912 (Search version file) 
      \Resource  
             \CMap  
               AdobeFnt.lst 417 
               Identity-H 1,614 
               Identity-V 1,527 
            \Font  
               _a______.pfb 32,084 
               _ab_____.pfb 31,966 
               _abi____.pfb 32,019 
               _ai_____.pfb 32,115 
               _eb_____.pfb 35,377 
               _ebi____.pfb 38,543 
               _ei_____.pfb 37,518 
               _er_____.pfb 35,380 
               AdobeFnt.lst 6,291 
               cob_____.pfb 35,500 
               cobo____.pfb 50,532 
               com_____.pfb 34,585 
               coo_____.pfb 48,468 
               Sy______.pfb 34,705 
               Zd______.pfb 49,593 
               Zx______.pfb 75,573 
               Zy______.pfb 96,418 
                  \PFM  
                     _a______.pfm 5,809 
                     _ab_____.pfm 5,330 
                     _abi____.pfm 5,336 
                     _ai_____.pfm 5,816 
                     _eb_____.pfm 4,941 
                     _ebi____.pfm 4,683 
                     _ei_____.pfm 4,815 
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                     _er_____.pfm 4,692 
                     Cob_____.pfm 679 
                     Cobo____.pfm 686 
                     Com_____.pfm 674 
                     Coo_____.pfm 682 
                     Sy______.pfm 672 
                     Zd______.pfm 684 
                     Zx______.mmm 7,248 
                     Zx______.pfm 683 
                     Zy______.mmm 7,248 
                     Zy______.pfm 684 
 
     \Install 
           rs40eng.exe 6,486,144   (Eng. Installer with Search) 

 

 

[End of Listing/Article] 
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Appendix D - Adobe Technical Support Documentation - Times and 
Helvetica Aren't Installed with Acrobat 4.0 (#322792) 

Adobe Acrobat 4.0 does not include the Type 1 fonts Helvetica and Times, unlike previous 
versions of Acrobat. Instead, it includes the Type 1 fonts MT Arial and MT Times New 
Roman from Monotype.  

MT Arial and MT Times New Roman have spacing and character shapes nearly identical 
to those of Helvetica and Times, respectively. MT Arial and MT Times New Roman are 
different from the Microsoft versions of Arial and Times New Roman (e.g., the MT versions 
include the Euro character, which is the symbol for the currency of the European Union). 

While you usually you won't notice any change with these new fonts, either on-screen or in 
print, you may see unexpected font behaviour.  

Some different behaviour with the new fonts may be obvious to the trained eye. If you're 
viewing a PDF file containing Helvetica or Times, and the font is neither embedded in the 
PDF file nor installed on your system, Acrobat 4.0 viewers will substitute the font using 
either MT Arial or MT Times New Roman. While MT Arial and MT Times New Roman are 
very similar to Helvetica and Times, respectively, they are not identical. 

For example, a PDF file containing Helvetica or Times that was created with Acrobat 3.0x 
or earlier will not have the font embedded. If you view that PDF file in an Acrobat 4.0 
viewer, the viewer will substitute Helvetica or Times with MT Arial or MT Times New 
Roman. If you print that PDF file to a PostScript printer, the Acrobat viewer won't 
download MT Arial or MT Times New Roman; instead, it will print the file using the printer's 
installed version of Helvetica or Times. The printed file will, therefore, look identical to the 
original. (The Acrobat viewer will automatically download the Euro character if needed.) If 
you print to a non-PostScript printer, the Acrobat viewer will download MT Arial or MT 
Times New Roman font information. The printed file will, therefore, probably look slightly 
different from the original. 

An Acrobat 4.0 viewer will substitute Helvetica or Times with MT Arial or MT Times New 
Roman even if Helvetica or Times is installed on your system. The Acrobat viewer 
searches for fonts first in the PDF files. If the fonts aren't embedded, the viewer checks the 
Acrobat:Resource:Font folder (Mac OS) or the Acrobat4\Resource\Font folder (Windows). 
If the fonts aren't there, the viewer checks the system. If the fonts aren't installed, the 
viewer simulates the fonts using its multiple master fonts. The viewer searches for fonts in 
this order to ensure that the newest versions of Acrobat's multiple master substitution fonts 
are read before any older versions in the System Folder (Mac OS) or the 
Windows\System folder (Windows) are read. Older versions of the multiple master 
substitution fonts, such as those included with Adobe Type Manager (ATM), don't include 
the Euro character. 

If your workflow requires that your PDF file contain Helvetica or Times, do either of the 
following: 

n Re-create the PDF file using Acrobat Distiller 4.0, and embed Helvetica and Times. 
For information on embedding fonts, see "Embedding fonts in PDF files with Distiller" 
in the Acrobat 4.0 User Guide. 
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n View and print the PDF file in an Acrobat 3.0x viewer. Acrobat 3.0x viewers don't 
include MT Arial and MT Times New Roman, so they won't substitute them for 
Helvetica and Times.  

[End of Article] 
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Appendix E - Adobe Technical Support Documentation How Acrobat 
4.x Viewers Handle Fonts and Font Information (#322902 ) 

 

What's Covered 

n Fonts Installed by Acrobat  

n How Acrobat Viewers Retrieve Font Information 

n How to View a PDF File's Font Information 

n Testing How Fonts Will Appear Using Acrobat 

This document describes how Adobe Acrobat 4.0 viewers handle fonts and font 
information. For more information about how Acrobat 4.0 viewers handle fonts, see the 
Acrobat User Guide or the Acrobat Reader online guide. 

 

Fonts Installed by Acrobat 

Acrobat installs the following Type 1 fonts, which are called the Base 14 fonts, into its 
Resources\Fonts folder: 

n Courier (Regular, Bold, Italic, and Bold Italic) 

n Arial MT (Regular, Bold, Oblique, and Bold Oblique) 

n Times New Roman PS MT (Roman, Bold, Italic, and Bold Italic) 

n Symbol  

n ZapfDingbats 

These Base 14 fonts are usually not embedded in PDF files, because they're commonly 
installed on most computers. Acrobat installs them to ensure they're available to Acrobat 
viewers, even if they're not installed on a given computer. 

Acrobat also installs its multiple master substitution fonts, Adobe Sans and Adobe Serif, in 
the Acrobat Resources\Fonts folder. 

 

How Acrobat Viewers Retrieve Font Information 

An Acrobat viewer completes a series of steps to retrieve font information when opening a 
PDF file. It first checks the PDF file for font information, such as embedded or subsetted 
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fonts, then uses that font information to display text. If there is no font information in the 
PDF file, the viewer checks to see if the fonts specified in the PDF file are in its 
Resources\Fonts folder. If they are in the Resources\Fonts folder, the viewer uses them. 

Note: If the PDF file contains text formatted with Helvetica or Times, and these fonts are 
not embedded, the viewer will use Arial MT or Times New Roman PS MT from the 
Resources\Fonts folder for Helvetica or Times, respectively. The viewer will do this even if 
Helvetica or Times is active on the system. 

If the fonts aren't in the Resources\Fonts folder, the viewer checks to see if the fonts are 
active on the system. Fonts are active if they're installed in the system's Fonts folder or 
activated in a font management utility, such as Adobe Type Manager (ATM). If the fonts 
are active, the viewer uses them. 

If the viewer doesn't find any of the fonts in specified in the PDF file, it simulates fonts 
using its Adobe Sans and Adobe Serif multiple master fonts. The approximate shapes and 
spacing for the fonts are defined in font metrics saved within the PDF file. 

 

How to View a PDF File's Font Information 

To view the font information for a PDF file, open the PDF file in an Acrobat viewer and 
choose File > Document Info > Fonts. The Font Info dialog box displays font information 
for only the text that has been viewed in the PDF. To see a list of all the fonts used in the 
document, click List All Fonts.  

The Font Info dialog box displays the following information. For more information about the 
Font Info dialog box in Acrobat 4.0 viewers, see the Acrobat User Guide or the Acrobat 
Reader online guide. 

Original Font 
This column lists the font used in the original document from which the PDF file was 
created. 

Type 
This columns lists the Original Font type. The font type is typically Type 1 or TrueType, but 
you may also see T3 and T4 listed, which are typically Type 3 fonts. 

Encoding 
This column indicates the type of encoding used in the Original Font. Font encoding is 
typically Windows, MacRoman, Custom, or Built-in:  

Windows and MacRoman are the standard font encoding types for Windows and Mac OS, 
respectively. (To improve cross-platform results, most applications that create PDF files 
use Windows encoding.) 

Custom encoding means that the encoding vector for the font is in the PDF file -- that 
every character in the font and its font metrics are listed in the PDF file. Custom encoding 
is typically used with expert fonts.  

Built-in encoding means that the information for every character in the font and its code 
point are included, rather than defined by the system or with custom encoding. Built-in 
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encoding is generally used with embedded system and TrueType fonts, particularly 
symbol fonts (e.g., pi). 

Used Font 
This column indicates whether the font that the viewer uses is embedded or subsetted, 
installed on the system, or is a multiple master font substitution. 
 
Type 
This column indicates what type of font the Used Font is. 

 

Testing How Fonts Will Appear Using Acrobat 

In Acrobat 4.0 (but not Acrobat Reader 4.0), you can see how the fonts your PDF file will 
look on a system that does not have the fonts installed. Choose View > Use Local Fonts to 
specify whether Acrobat should ignore the fonts installed on your system. (The command 
has a check mark by it when Acrobat is using the fonts and no check mark when Acrobat 
is ignoring the fonts.) When Use Local Fonts is off (that is, it does not have a check mark 
by it), Acrobat displays the PDF file with substitute fonts for all fonts that are not 
embedded. If a font cannot be substituted, the text formatted with that font appears as 
bullets, and Acrobat displays an error message.  

If the text in your PDF file appears as bullets when Use Local Fonts is off, you should 
embed the fonts used to format that text in your PDF file.  

 

[End of Article] 
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Appendix F - Useful references 

 

Acrobat & PDF: 

CompuServe Adobe forums - Go ADOBEA - (where this project started). 

Adobe web site (www.adobe.com) [Links are correct for Oct ’99 new Adobe site] 

Technical Support - technotes etc.  

Developer info - SDK.  

General downloads - Acrobat patches, etc.  

Reader installers - different (platform/language) versions of Acrobat Reader.  

Reader CD-ROM - Info on a CD-ROM containing all language versions of Reader for 
a given platform (1 CD each for Windows, Mac and Unix). 

Adobe user forums  (Good, but note you have to register (free) and log in and to use.  
You can only read the forums online). 

PDF Zone (www.pdfzone.com) 

Tips, info on tools/plug-ins, discussion forums (run as a list, not a newsgroup, though 
there are searchable archives available online). 

Planet PDF (www.planetpdf) 

Tips, info on tools/plug-ins, news.  Partner sites: CodeCuts, AcroBuddies 

CodeCuts (www.codecuts.com) 

Acrobat programming tips, code examples. 

AcroBuddies (www.acrobuddies.com) 

User-to-User help forum - requires registration and log-in 

PDF newsgroup (comp.text.pdf) 

 

AutoPlay CDs on the PC: 

Microsoft (www.microsoft.com) (www.msdn.microsoft.com) 

Info on AutoPlay CDs.  Use Search page, Knowledge Base and MSDN. 

Pollen Software (www.pollensoftware.com) 

Various shareware utilities to extend AutoPlay  
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CD-R software  

Adaptec (www.adaptec.com) 

Easy CD Creator Deluxe (PC) and Toast (Mac) CD-R software  

SCSI info. 

Ahead (www.ahead.de) 

Nero CD-R software 

CeQuadrat (www.Cequadrat.com) 

WinOnCD CD-R software 

 

Cross-platform Utilities 

MacDisk (www.macdisk.com) 

Software for preparing hybrid CDs, reading Mac media on a PC: 

MacDisk 
MacScuzzy 
MacImage 

Dataviz (www.dataviz.com) 

Utilities for reading Mac media on a PC  

 

Information about CD-R 

CD Info (www.cd-info.com) 

Andy McFadden’s CD-R FAQ - a good reference 
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Appendix G - The Adobe Reader CD-ROM 

 

What is on the Reader CD-ROM? 

[Drawn from information at www.adobe.com/products/acrobat/cdrom40.html] 

The Adobe® Acrobat® Reader 4.0 CD-ROM, which contains all 54 versions of Acrobat 
Reader. This CD-ROM includes versions of Acrobat Reader for the Windows®, 
Macintosh®, and UNIX® platforms, in all supported languages (see table below), plus 
Acrobat Reader with Search for those languages that currently have Search support. 
(Note: The UNIX versions are in English only. Linux and SunTM SolarisTM X86 versions do 
not include Search.) 

Acrobat Reader 4.0 with Search consists of Acrobat Reader and two Acrobat plug-ins: 
Acrobat Search and AutoIndx. This alternate configuration of Acrobat Reader lets you 
search through a collection of Adobe PDF files on a CD-ROM or a local file system. (The 
PDF files must have been indexed using Acrobat Catalog, a tool included with Adobe 
Acrobat 4.0.) 

The Acrobat Reader 4.0 CD-ROM also includes all four of Adobe's Asian Font Packs, so 
you can view documents created in Japanese, Chinese (Traditional and Simplified), and 
Korean. 

Language Reader Reader + Search 

English Yes Yes 

French Yes Yes 

German Yes Yes 

Dutch Yes Yes 

Italian Yes Yes 

Swedish Yes Yes 

Spanish Yes Yes 

Japanese Yes  

Portuguese Yes  

Chinese Simplified Yes  

Chinese Traditional Yes  

Korean Yes  
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Hebrew Yes  

Arabic Yes  

 

 Note: The Arabic and Hebrew versions of Acrobat Reader install with an English or 
French user interface. 

 

Pricing and Availability 

[As at September 1999 - check Adobe’s web site for new/local pricing] 

Adobe® Acrobat® Reader 4.0 is a free download. However, if you wish to purchase the 
Acrobat Reader 4.0 CD-ROM, which includes Acrobat Reader with Search, there is a 
charge.  The CD comes in Windows, Mac and Unix versions and each costs online US$ 
14.95 or US$ 19.95 ordered over the phone.  There is a charge per CD/platform, so 
ordering the windows and Mac CDs online would cost US$ 29.90, etc. 

 

System Requirements 

See Appendix I. 

 

Distributing Acrobat Reader 

You can distribute the free Adobe Acrobat Reader software to anyone inside or outside 
your company who needs to view, navigate, and search PDF files.  

You may make unlimited copies of this software and give copies to other persons or 
entities as long as those copies contain the Electronic End-User License Agreement and 
the same copyright and other proprietary notices that appear on or in the software. The 
license agreement, copyright notices, and other notices are contained in the Acrobat 
Reader installer program; so as long as you do not alter the installer program in any way 
you will be in compliance with the agreement. You can also see the online version of the 
license agreement. 

If you are redistributing the Acrobat Reader in your product, you may include the "Includes 
Adobe Acrobat" logo. Download the EPS "Includes Adobe Acrobat" logo files in Macintosh 
or Windows format and fill out the logo agreement by following the directions 
(Readerlo.pdf) in the archived package.  

All of the Acrobat Readers can be redistributed without any further permission from 
Adobe.   Adobe are very interested in keeping track of who is distributing the Acrobat 
Reader and ask that as part of your distribution registration you provide the following  
information at their web site: 
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n Name 
n Company 
n Product it is shipping with 
n Shipping date of product 
n Estimated end of life of product 
n Email contact 
n Phone contact 

 

Using Adobe Acrobat Trademarks: Adobe Product Signatures and the Acrobat 
Button and PDF Icons  

To use Adobe product signatures and the icons shown at the top of their distribution page, 
you must license them from Adobe Systems Incorporated. Complete the Adobe 
Trademark License Agreement for the product signatures and PDF and Get Acrobat 
Reader icons above by filling out the license agreement online.  

Note: The Get Acrobat Reader button and PDF file icons may not be modified in any 
manner, including text, size, and colour. 
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Appendix H - TechDocs Document Index: Acrobat (#250099) 

[Based on Adobe TS Document number 250099 with additions] 

The Adobe technical support documents listed below are available from the following 
sources: 

n Adobe Technical Solutions database on the World Wide Web at  
www.adobe.com/support/database.html 

n Adobe's automated faxing system, FaxYI, at 650-556-8481 
n Adobe's auto-response e-mail system, Techdocs, at techdocs@adobe.com 

Each document's number appears to the left of its title. You'll need the number to order a 
document from FaxYI or Techdocs, and you can use the number to search for a 
document on the Adobe Web site. To order a document from Techdocs, include only the 
document number in the subject line and address the e-mail to techdocs@adobe.com. 

All Products 

110099 Mac OS and Windows Products (Document Index) 
322902 How Acrobat 4_x Viewers Handle Fonts and Font Information 
322792 Times and Helvetica Aren't Installed with Acrobat 4_0 

Acrobat Capture for Mac OS 

320327 Error "PDF page contains graphics other than images or text..." in Acrobat 
Capture 

Acrobat Capture for Windows 

316732 Acrobat Capture 2.0 Returns Error or Freezes When Processing Pages 
320432 Acrobat Capture 2.01 for Windows New Features 
315622 Capture 2.0 Doesn't Recognize Files in Input Folders and OLE Error Occurs 
310475 Error "Acrobat PDF Writer Error. Insufficient room" in Acrobat Capture or Capture 

Reviewer 
310271 Error "Another application is using the file MSVCRT20.DLL..." When Installing 

Capture 1.01 
310840 Error "Can't open system level scanner driver...[-4428]" When Scanning in 

Acrobat Capture or Exchange 
314940 Error "Capture Server failed to respond" or "Acrobat PDFWriter Error" in Acrobat 

Capture 2.0 
321678 Error "Could not initialize OLE" When Starting Acrobat Capture 2.01 
322376 Error "Font...cannot be found or system resources are too low" in Acrobat Capture 

or Exchange for Windows 
310175 Error "Hardware key not found" When Processing in Acrobat Capture 2.0x 
311790 Error "mem_bad_pointer" When Processing TIFF in Acrobat Capture 
320327 Error "PDF page contains graphics other than images or text..." in Acrobat 

Capture 
311333 Error "PDFWriter: Out of memory" in Acrobat Capture Reviewer 2.0 or Acrobat 

Capture 2.0 
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319803 Error "...problem reading this document (9)" Opening PDF File in Acrobat 2.1 
Viewer 

315642 Fonts Installed with Acrobat Capture 
312431 Installed Fujitsu Scanner Does Not Appear in Capture's Scanner Device List 
317214 ISIS Drivers General Information and Availability 
316167 ISIS Drivers Installed by Acrobat Capture 2.0 in Windows 95 
313927 ISIS Drivers Installed by Acrobat Capture 2.0 in Windows NT 
312311 Manually Removing Acrobat Capture 1.01 for Windows from Your System 
320033 Manually Removing Acrobat Capture 2.0 from Windows 95 and Windows NT 4.0 
320085 Optimizing Performance in Acrobat Capture 2.0 for Windows 
320337 Simplifying Windows 95 or Windows 98 to Troubleshoot System Errors in Acrobat 

Applications 
313100 Troubleshooting ISIS Scanning Problems with Acrobat Capture Scan Command 

and Exchange Scan Plug-in 
316483 Troubleshooting TWAIN Scanning Problems in Acrobat 
310929 Uninstalling Acrobat Capture 2.0 for Windows 

Acrobat Catalog for Mac OS 

314561 Top Issues: Adobe Acrobat 3.0 
318504 Manually Removing Acrobat 3.0x from Mac OS 7.x or 8.0.x 
316082 Networks Supported by Acrobat Catalog 3.0 
321627 Searching the Contents of PDF Files on a Web Site 
312303 System Error or Freeze When Building Index in Acrobat Catalog for Mac OS 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
320271 Troubleshooting System Errors and Freezes in Mac OS 8.0 When Starting an 

Acrobat Application 
320139 Why the Title in Search Results Doesn't Always Match the PDF Filename 

Acrobat Catalog for UNIX 

316082 Networks Supported by Acrobat Catalog 3.0 
320237 Using Acrobat Catalog to Create Indexes That Work in UNIX 

Acrobat Catalog for Windows 

314561 Top Issues: Adobe Acrobat 3.0 
311326 Acrobat Catalog Returns an Error When Building an Index 
311426 Adding a List of Stopwords to an Acrobat Catalog Index 
310434 Error "Cannot read/access" Index or "Index not available" for PDF File on Network 

Drive 
312839 Error "General Protection Fault in module Compcore.dll at 0001.03DF" Building 

Index in Acrobat Catalog 
316616 Error "Internal Error has Occurred. Can't Retrieve Results. Sorry." When 

Searching Index With Exchange 
312368 Error "The index is currently unavailable..." When Attaching To or Searching Index 

in Acrobat Exchange or Reader 
315219 Files Associated with an Acrobat Catalog Index 
314459 Modifying Acrobat Catalog Settings Using the SDK or the Acrocat.ini File 
323421 Must Be Logged In to Windows NT as Administrator to Install Acrobat 4.0 

Applications 
316082 Networks Supported by Acrobat Catalog 3.0 
321627 Searching the Contents of PDF Files on a Web Site 
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320337 Simplifying Windows 95 or Windows 98 to Troubleshoot System Errors in Acrobat 
Applications 

320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
321798 Troubleshooting Problems with PDF Ifilter 
320139 Why the Title in Search Results Doesn't Always Match the PDF Filename 

Acrobat Distiller for Mac OS 

314561 Top Issues: Adobe Acrobat 3.0 
320214 Acrobat Distiller 3.02 Doesn't Start When You Export a PDF from PageMaker 6.x 
320112 Acrobat Distiller 3.02 Upgrade Information and Installation Instructions 
313928 Acrobat Distiller Returns an Error When Distilling a PostScript File 
315034 Captured Screen Images in Acrobat PDF Files 
321454 Characters Missing in PDF File Created from LaTeX or TeX PostScript File 
311854 Creating a PDF File from a FrameMaker 5 Document 
315353 Creating a PostScript File from PageMaker for Use with Acrobat Distiller 
316464 Creating a PostScript File from QuarkXPress 3.x for Mac OS for Use with Acrobat 

Distiller 
322140 Creating a PostScript File to Use With Acrobat Distiller or Printing to PDF from 

QuarkXPress 4.x in Windows 
312143 Creating quality Adobe PDF files from TeX with DVIPS by Kendall 

Whitehouse/EMERGE 
317218 Distiller Displays Messages About Destinations When Creating PDF from 

FrameMaker 5.0 - 5.2 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
310493 Error "Invalidfont: OffendingCommand: findfont" in Acrobat Distiller 3.0x 
319266 How Acrobat Distiller and PDF Writer Handle Fonts 
321885 How to Prevent Acrobat Distiller 3.0x from Simulating or Substituting Fonts 
318504 Manually Removing Acrobat 3.0x from Mac OS 7.x or 8.0.x 
319339 PDF File from Acrobat Distiller 3.02 Doesn't Contain Color Separation Information 
320438 Recommendations for Creating PDF Files in Word 97 
319033 Recommendations for High-End Settings in Acrobat Distiller 3.02 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
320271 Troubleshooting System Errors and Freezes in Mac OS 8.0 When Starting an 

Acrobat Application 
320690 Using Cyrillic Fonts in Acrobat PDF Files 
318674 Using Runfilex and Rundirex in Acrobat Distiller to Create One PDF from Multiple 

PostScript Files 

Acrobat Distiller for UNIX 

321478 Top Issues: Acrobat 3.0x for UNIX 
320315 Acrobat Availability on UNIX Platforms 
321572 Acrobat Distiller for UNIX Parameters for the Preferences File or Command Line 
317218 Distiller Displays Messages About Destinations When Creating PDF from 

FrameMaker 5.0 - 5.2 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
320562 Error "No configurations found...aborting" When Installing Acrobat 3.x for UNIX 
320835 PostScript Files Take a Long Time to Distill in Acrobat Distiller for UNIX 
319033 Recommendations for High-End Settings in Acrobat Distiller 3.02 
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Acrobat Distiller for Windows 

314561 Top Issues: Adobe Acrobat 3.0 
320112 Acrobat Distiller 3.02 Upgrade Information and Installation Instructions 
311407 Acrobat Distiller 3.0x Checks Watched Folders Too Soon 
320716 Acrobat Distiller Assistant 3.0x for Windows 95, Windows 98, and Windows NT 

4.0 
312949 Acrobat Distiller Assistant Doesn't Appear in Printers Folder in Windows 95, 

Windows 98, or Windows NT 4.0 
313928 Acrobat Distiller Returns an Error When Distilling a PostScript File 
315034 Captured Screen Images in Acrobat PDF Files 
321454 Characters Missing in PDF File Created from LaTeX or TeX PostScript File 
320715 Colors Are Incorrect in a PDF File Created from a PowerPoint Presentation 
311854 Creating a PDF File from a FrameMaker 5 Document 
315353 Creating a PostScript File from PageMaker for Use with Acrobat Distiller 
313598 Creating a PostScript File from QuarkXPress 3.x for Windows for Use with 

Acrobat Distiller 
315478 Creating a PostScript File from Ventura Publisher 5.0 for Use with Acrobat Distiller 
322140 Creating a PostScript File to Use With Acrobat Distiller or Printing to PDF from 

QuarkXPress 4.x in Windows 
312143 Creating quality Adobe PDF files from TeX with DVIPS by Kendall 

Whitehouse/EMERGE 
317218 Distiller Displays Messages About Destinations When Creating PDF from 

FrameMaker 5.0 - 5.2 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
310450 Error "'\Distasst.ps' is an invalid port name" When Installing Acrobat Distiller 3.0x 
310124 Error "Could not launch Distiller. Distiller Assistant will Terminate" in Windows NT 

4.0 
310493 Error "Invalidfont: OffendingCommand: findfont" in Acrobat Distiller 3.0x 
317205 Error "Low Printer VM" When Saving a FrameMaker 5.5 for Windows 95 Book as 

PDF 
317205 Error "Low Printer VM" When Saving a FrameMaker 5.5 for Windows 95 Book as 

PDF 
323931 Error "No timers available" When Starting Acrobat Distiller 4.0 in Windows NT 
319266 How Acrobat Distiller and PDF Writer Handle Fonts 
321885 How to Prevent Acrobat Distiller 3.0x from Simulating or Substituting Fonts 
323421 Must Be Logged In to Windows NT as Administrator to Install Acrobat 4.0 

Applications 
319339 PDF File from Acrobat Distiller 3.02 Doesn't Contain Color Separation Information 
320438 Recommendations for Creating PDF Files in Word 97 
319033 Recommendations for High-End Settings in Acrobat Distiller 3.02 
320337 Simplifying Windows 95 or Windows 98 to Troubleshoot System Errors in Acrobat 

Applications 
323662 Text in Grouped Text Boxes Is Missing from PDF Files Created with PDFMaker in 

Word 97 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
320690 Using Cyrillic Fonts in Acrobat PDF Files 
318674 Using Runfilex and Rundirex in Acrobat Distiller to Create One PDF from Multiple 

PostScript Files 

Acrobat (Exchange) for Mac OS 

314561 Top Issues: Adobe Acrobat 3.0 
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314180 Acrobat Exchange 3.0x and Acrobat 4.0 Security Settings 
320255 Acrobat Forms Author Plug-in and Forms Fill-in Plug-in Information and 

Availability 
323708 Acrobat Viewer Doesn't Print Pages with Multiple Page Sizes to Multiple Paper 

Trays 
323838 Can't Print Pages with Non-Numeric Page Numbers in Acrobat Viewers for Mac 

OS 
315034 Captured Screen Images in Acrobat PDF Files 
323084 Characters Appear as Bullets in Acrobat PDF File 
314807 Configuring Internet Explorer for Mac OS to Display PDF Files 
314544 Configuring Netscape Navigator for Mac OS to Display PDF Files 
313114 Configuring Netscape Navigator for Mac OS to Recognize Acrobat Reader or 

Acrobat Exchange 2.1 or Earlier 
315385 Creating Link to a Specific PDF Page Using Named Destinations 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
322066 Error or Freeze When Starting Acrobat Exchange 3.0x in Mac OS 8.5 or Later 
316374 Error "Capture Server could not process page(s)" When Capturing in Acrobat 

Exchange or Acrobat 4.0 
323505 Error "DXTN 'watermark' reports an error..." When Printing from Acrobat 4.0 with 

AdobePS 
322960 Error "File does not begin with '%PDF-'" When Clicking a Downloadable File in a 

Web Browser 
311277 Error "No scanners available" in Acrobat Exchange 3.01 or Later for Mac OS 
311596 Error "The Symbol font must be installed . . ." in Acrobat Reader or Acrobat 

Exchange 3.0x 
316430 Exchange Incorrectly Reports Fonts in a PDF File as Embedded 
311633 Graphics Print Blurry from Acrobat 3.01 Viewer to a PCL Printer 
321474 How Acrobat 3.x Viewers Handle Fonts and Font Information 
323695 How to Extract Text and Graphics from a PDF File 
318504 Manually Removing Acrobat 3.0x from Mac OS 7.x or 8.0.x 
320487 PDF Embedded in HTML Document Displays Only One Page in Netscape 

Navigator 
311184 PDF Pages Are Blank Inside Web Browser Window 
313827 PostScript Error "typecheck" When Printing from Acrobat Reader 3.01 or 

Exchange 3.01 
312047 Screen Capture Image Looks Worse in Acrobat Viewer than in Microsoft Office 
321627 Searching the Contents of PDF Files on a Web Site 
313228 Text Attributes Aren't Retained When Copied from Exchange 
311237 Text in PDF File Appears Blurry in Acrobat Viewer 
322551 Text Is Jagged in PDF File Created from LaTeX or TeX PostScript File 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
315727 Troubleshooting Printing Problems in Acrobat for Mac OS 
320271 Troubleshooting System Errors and Freezes in Mac OS 8.0 When Starting an 

Acrobat Application 
320418 Unable to Fill in Form Fields of a PDF File 
320690 Using Cyrillic Fonts in Acrobat PDF Files 
315645 Weblinks Don't Work Using Acrobat Viewer as Helper Application in a Web 

Browser 

Acrobat (Exchange) for UNIX 

321478 Top Issues: Acrobat 3.0x for UNIX 
320315 Acrobat Availability on UNIX Platforms 
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320255 Acrobat Forms Author Plug-in and Forms Fill-in Plug-in Information and 
Availability 

323708 Acrobat Viewer Doesn't Print Pages with Multiple Page Sizes to Multiple Paper 
Trays 

323084 Characters Appear as Bullets in Acrobat PDF File 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
322960 Error "File does not begin with '%PDF-'" When Clicking a Downloadable File in a 

Web Browser 
320562 Error "No configurations found...aborting" When Installing Acrobat 3.x for UNIX 
323695 How to Extract Text and Graphics from a PDF File 
318675 Printing from Acrobat Reader and Exchange for UNIX Using the LP or LPR 

Command 
322551 Text Is Jagged in PDF File Created from LaTeX or TeX PostScript File 

Acrobat (Exchange) for Windows 

314561 Top Issues: Adobe Acrobat 3.0 
320325 Acrobat's ActiveX Control Is Not Full-Featured Control 
314180 Acrobat Exchange 3.0x and Acrobat 4.0 Security Settings 
320255 Acrobat Forms Author Plug-in and Forms Fill-in Plug-in Information and 

Availability 
311134 Acrobat PDFWriter 3.0x or 4.0 Doesn't Appear in Windows Printers Control Panel 
323708 Acrobat Viewer Doesn't Print Pages with Multiple Page Sizes to Multiple Paper 

Trays 
315034 Captured Screen Images in Acrobat PDF Files 
323084 Characters Appear as Bullets in Acrobat PDF File 
315029 Configuring Internet Explorer and AOL for Windows 95, Windows 98, and 

Windows NT 4.0 to Display PDF Files 
313692 Configuring Netscape Navigator for Windows to Display PDF Files 
315385 Creating Link to a Specific PDF Page Using Named Destinations 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
310840 Error "Can't open system level scanner driver...[-4428]" When Scanning in 

Acrobat Capture or Exchange 
316374 Error "Capture Server could not process page(s)" When Capturing in Acrobat 

Exchange or Acrobat 4.0 
310345 Error "Document could not be printed...drawing error" in an Acrobat Viewer 
322960 Error "File does not begin with '%PDF-'" When Clicking a Downloadable File in a 

Web Browser 
322376 Error "Font...cannot be found or system resources are too low" in Acrobat Capture 

or Exchange for Windows 
311995 Error "Invalid Page Fault in Module Kernel32.dll" When Viewing PDF in Exchange 

3.0x 
311408 Error "No scanners available or error querying available scanners" When 

Scanning in Acrobat Exchange 3.0 
323047 Error "Nothing Done. Timed Out" When Trying to Capture Web Pages in Acrobat 
310521 Freeze or Error in Internet Explorer for Windows NT When Viewing PDF File 
311633 Graphics Print Blurry from Acrobat 3.01 Viewer to a PCL Printer 
321474 How Acrobat 3.x Viewers Handle Fonts and Font Information 
312906 How to Bypass Acrobat PDFWriter's Save As Dialog Box 
313363 How to Embed PDF Files in Lotus Notes 3.x Using Notes/FX 
323695 How to Extract Text and Graphics from a PDF File 
311040 HP Scanner Drivers Installed with Acrobat Exchange 3.01 and Acrobat Capture 

2.0 for Windows 
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315064 Install Structure Acrobat Reader 3_0 (CD-ROM) 
310719 Installed Structure Acrobat 3_0 Installed for Windows 
312902 Installed Structure Acrobat 3_01 in Windows NT 4_0 
313779 Installed Structure Acrobat 3_01 in Windows 95 
311875 Installed Structure Acrobat Capture 2_0 in Windows NT 4_0 
314501 Installed Structure Acrobat Capture 2_0 in Windows 95 
310855 Installed Structure Acrobat Reader 3_0 for Windows 3_1 (Onefile Installer) 
311391 Installed Structure Acrobat Reader 3_0 in Windows 95 and NT 4_0 (Onefile 

Installer) 
311163 Installed Structure Acrobat Reader 3_0 with Search for Windows 95 
313847 Installed Structure Acrobat Reader 3_01 for Windows 95 
323968 Installed Structure Acrobat Reader 3_01 for Windows NT 4_0 
323196 Installed Structure Acrobat 4_0 for Windows 95 and Windows 98 
314068 Internet Explorer 4.0 for Windows Doesn't Download PDF Files a Page at a Time 
319909 Internet Explorer Displays PDF Files as Blank Pages with Personal Web Server 
317214 ISIS Drivers General Information and Availability 
314485 ISIS Drivers Installed by Acrobat 3.0 in Windows 95 
314722 ISIS Drivers Installed by Acrobat 3.0 under Windows NT 4.0 
323284 Keyboard Shortcuts for Acrobat 4.0 for Windows 
323421 Must Be Logged In to Windows NT as Administrator to Install Acrobat 4.0 

Applications 
310824 New Features in Adobe Acrobat 3.0 
320487 PDF Embedded in HTML Document Displays Only One Page in Netscape 

Navigator 
314437 PDF Files Do Not Print Or Print Only Partially to a PostScript Printer 
311184 PDF Pages Are Blank Inside Web Browser Window 
313827 PostScript Error "typecheck" When Printing from Acrobat Reader 3.01 or 

Exchange 3.01 
312047 Screen Capture Image Looks Worse in Acrobat Viewer than in Microsoft Office 
321627 Searching the Contents of PDF Files on a Web Site 
320337 Simplifying Windows 95 or Windows 98 to Troubleshoot System Errors in Acrobat 

Applications 
313062 Some Objects and Text in a PDF Don't Print to PCL Printers 
313228 Text Attributes Aren't Retained When Copied from Exchange 
311237 Text in PDF File Appears Blurry in Acrobat Viewer 
322551 Text Is Jagged in PDF File Created from LaTeX or TeX PostScript File 
323407 Text Prints with No Spaces from Acrobat 4.0 Viewer to HP PCL Printers 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
311705 Troubleshooting PostScript Printer Problems and Improving Printer Performance 
316508 Troubleshooting Printing Problems in Acrobat for Windows 
316483 Troubleshooting TWAIN Scanning Problems in Acrobat 
320418 Unable to Fill in Form Fields of a PDF File 
321263 Using Acrobat Forms and Form Data on the Web 
320690 Using Cyrillic Fonts in Acrobat PDF Files 
313219 Using HP ScanJet 6100 with Acrobat Exchange 3.0x or Acrobat Capture 2.0 
315645 Weblinks Don't Work Using Acrobat Viewer as Helper Application in a Web 

Browser 

Acrobat Reader for Mac OS 

314561 Top Issues: Adobe Acrobat 3.0 
311837 Top Issues: Adobe Acrobat Reader 3.0x for Mac OS 
310327 Acrobat Reader Support Resources 
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323708 Acrobat Viewer Doesn't Print Pages with Multiple Page Sizes to Multiple Paper 
Trays 

323838 Can't Print Pages with Non-Numeric Page Numbers in Acrobat Viewers for Mac 
OS 

323084 Characters Appear as Bullets in Acrobat PDF File 
314807 Configuring Internet Explorer for Mac OS to Display PDF Files 
314544 Configuring Netscape Navigator for Mac OS to Display PDF Files 
313114 Configuring Netscape Navigator for Mac OS to Recognize Acrobat Reader or 

Acrobat Exchange 2.1 or Earlier 
323115 Creating a CD to Distribute Acrobat Reader 
320287 Determining Which Acrobat Reader Installer to Run on Acrobat 3.01 for Mac OS 

CD-ROM 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
322960 Error "File does not begin with '%PDF-'" When Clicking a Downloadable File in a 

Web Browser 
311596 Error "The Symbol font must be installed . . ." in Acrobat Reader or Acrobat 

Exchange 3.0x 
319294 Error "...File does not begin with '%PDF-'" When Opening PDF File Sent Via E-

Mail 
311633 Graphics Print Blurry from Acrobat 3.01 Viewer to a PCL Printer 
321474 How Acrobat 3.x Viewers Handle Fonts and Font Information 
318006 How to Select and Copy Text in Acrobat Reader and Acrobat Exchange 
315823 Introduction to Acrobat Reader 
318504 Manually Removing Acrobat 3.0x from Mac OS 7.x or 8.0.x 
316271 Operating Systems Supported by Acrobat Reader 3.0 
320487 PDF Embedded in HTML Document Displays Only One Page in Netscape 

Navigator 
311184 PDF Pages Are Blank Inside Web Browser Window 
313827 PostScript Error "typecheck" When Printing from Acrobat Reader 3.01 or 

Exchange 3.01 
312047 Screen Capture Image Looks Worse in Acrobat Viewer than in Microsoft Office 
311805 Search Button Dimmed in Acrobat Reader 3.x or Exchange 3.x for PDF Files on 

Adobe FAQ CD 
321627 Searching the Contents of PDF Files on a Web Site 
311237 Text in PDF File Appears Blurry in Acrobat Viewer 
322551 Text Is Jagged in PDF File Created from LaTeX or TeX PostScript File 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
315727 Troubleshooting Printing Problems in Acrobat for Mac OS 
314803 Troubleshooting Problems When Downloading or Installing Acrobat Reader 
320271 Troubleshooting System Errors and Freezes in Mac OS 8.0 When Starting an 

Acrobat Application 
320418 Unable to Fill in Form Fields of a PDF File 
320690 Using Cyrillic Fonts in Acrobat PDF Files 
315645 Weblinks Don't Work Using Acrobat Viewer as Helper Application in a Web 

Browser 

Acrobat Reader for UNIX 

321478 Top Issues: Acrobat 3.0x for UNIX 
314773 Top Issues: Acrobat Reader 3.0x for UNIX 
320315 Acrobat Availability on UNIX Platforms 
310327 Acrobat Reader Support Resources 
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323708 Acrobat Viewer Doesn't Print Pages with Multiple Page Sizes to Multiple Paper 
Trays 

323084 Characters Appear as Bullets in Acrobat PDF File 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
322960 Error "File does not begin with '%PDF-'" When Clicking a Downloadable File in a 

Web Browser 
320562 Error "No configurations found...aborting" When Installing Acrobat 3.x for UNIX 
317421 How to Install and Configure the Acrobat Plug-in in Netscape for UNIX 
318006 How to Select and Copy Text in Acrobat Reader and Acrobat Exchange 
315823 Introduction to Acrobat Reader 
320426 No Find Button in Acrobat Reader in Web Browser Window 
316271 Operating Systems Supported by Acrobat Reader 3.0 
318675 Printing from Acrobat Reader and Exchange for UNIX Using the LP or LPR 

Command 
322551 Text Is Jagged in PDF File Created from LaTeX or TeX PostScript File 

Acrobat Reader for Windows 

314561 Top Issues: Adobe Acrobat 3.0 
312599 Top Issues: Adobe Acrobat Reader 3.0 for Windows 
320325 Acrobat's ActiveX Control Is Not Full-Featured Control 
311769 Acrobat Reader Installer Doesn't Use Abcpy.ini Procedures 
310327 Acrobat Reader Support Resources 
323708 Acrobat Viewer Doesn't Print Pages with Multiple Page Sizes to Multiple Paper 

Trays 
323084 Characters Appear as Bullets in Acrobat PDF File 
315029 Configuring Internet Explorer and AOL for Windows 95, Windows 98, and 

Windows NT 4.0 to Display PDF Files 
315444 Configuring Navigator for Windows to Recognize Acrobat Reader or Acrobat 

Exchange 2.1 or Earlier 
313692 Configuring Netscape Navigator for Windows to Display PDF Files 
315406 Copy File To Clipboard Command Not Available in Acrobat Reader 3.0x for 

Windows 
323115 Creating a CD to Distribute Acrobat Reader 
321630 Embedded Fonts from Some Foundries Don't Appear in PDF Files As Expected 
321789 Error When Installing Acrobat Reader 3.01 Update for PCL Printing 
310345 Error "Document could not be printed...drawing error" in an Acrobat Viewer 
322960 Error "File does not begin with '%PDF-'" When Clicking a Downloadable File in a 

Web Browser 
310444 Error "Internal error has occurred" When Opening PDF in Internet Explorer 
317734 Error "Severe, unable to update the registry" When Installing Acrobat Reader 4.0 

for Windows NT 
319294 Error "...File does not begin with '%PDF-'" When Opening PDF File Sent Via E-

Mail 
310521 Freeze or Error in Internet Explorer for Windows NT When Viewing PDF File 
311633 Graphics Print Blurry from Acrobat 3.01 Viewer to a PCL Printer 
321474 How Acrobat 3.x Viewers Handle Fonts and Font Information 
318006 How to Select and Copy Text in Acrobat Reader and Acrobat Exchange 
314822 Installing Acrobat 2.1 Viewer on Diskless Workstations or from Disk Images 
314068 Internet Explorer 4.0 for Windows Doesn't Download PDF Files a Page at a Time 
319909 Internet Explorer Displays PDF Files as Blank Pages with Personal Web Server 
315823 Introduction to Acrobat Reader 
316396 Manually Removing Acrobat Reader 2.1 in Windows 
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321712 Manually Removing Acrobat Reader 3.0x from Windows 95, Windows 98, and 
Windows NT 4.0 

323180 McAfee VirusScan 4.x Incorrectly Reports Virus in Ar40.exe or Ar40eng.exe 
323421 Must Be Logged In to Windows NT as Administrator to Install Acrobat 4.0 

Applications 
320426 No Find Button in Acrobat Reader in Web Browser Window 
316271 Operating Systems Supported by Acrobat Reader 3.0 
312170 Password Requested by Acrobat Reader Installer 
320487 PDF Embedded in HTML Document Displays Only One Page in Netscape 

Navigator 
314437 PDF Files Do Not Print Or Print Only Partially to a PostScript Printer 
311184 PDF Pages Are Blank Inside Web Browser Window 
313827 PostScript Error "typecheck" When Printing from Acrobat Reader 3.01 or 

Exchange 3.01 
312047 Screen Capture Image Looks Worse in Acrobat Viewer than in Microsoft Office 
311805 Search Button Dimmed in Acrobat Reader 3.x or Exchange 3.x for PDF Files on 

Adobe FAQ CD 
321627 Searching the Contents of PDF Files on a Web Site 
320337 Simplifying Windows 95 or Windows 98 to Troubleshoot System Errors in Acrobat 

Applications 
311237 Text in PDF File Appears Blurry in Acrobat Viewer 
322551 Text Is Jagged in PDF File Created from LaTeX or TeX PostScript File 
323407 Text Prints with No Spaces from Acrobat 4.0 Viewer to HP PCL Printers 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
311705 Troubleshooting PostScript Printer Problems and Improving Printer Performance 
316508 Troubleshooting Printing Problems in Acrobat for Windows 
314803 Troubleshooting Problems When Downloading or Installing Acrobat Reader 
320418 Unable to Fill in Form Fields of a PDF File 
322064 Using a Setup.iss File for a Silent Installation of Acrobat Reader in Windows 
321263 Using Acrobat Forms and Form Data on the Web 
320690 Using Cyrillic Fonts in Acrobat PDF Files 
315645 Weblinks Don't Work Using Acrobat Viewer as Helper Application in a Web 

Browser 

Acrobat Writer for Mac OS 

314561 Top Issues: Adobe Acrobat 3.0 
315034 Captured Screen Images in Acrobat PDF Files 
312143 Creating quality Adobe PDF files from TeX with DVIPS by Kendall 

Whitehouse/EMERGE 
319266 How Acrobat Distiller and PDF Writer Handle Fonts 
318504 Manually Removing Acrobat 3.0x from Mac OS 7.x or 8.0.x 
320438 Recommendations for Creating PDF Files in Word 97 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
320271 Troubleshooting System Errors and Freezes in Mac OS 8.0 When Starting an 

Acrobat Application 
320690 Using Cyrillic Fonts in Acrobat PDF Files 

Acrobat Writer for Windows 

314561 Top Issues: Adobe Acrobat 3.0 
315034 Captured Screen Images in Acrobat PDF Files 
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312143 Creating quality Adobe PDF files from TeX with DVIPS by Kendall 
Whitehouse/EMERGE 

319266 How Acrobat Distiller and PDF Writer Handle Fonts 
323421 Must Be Logged In to Windows NT as Administrator to Install Acrobat 4.0 

Applications 
320438 Recommendations for Creating PDF Files in Word 97 
320337 Simplifying Windows 95 or Windows 98 to Troubleshoot System Errors in Acrobat 

Applications 
320976 Troubleshooting Installation Problems in Acrobat 4.0 for Windows 
320690 Using Cyrillic Fonts in Acrobat PDF Files 

Acrobat (multi-component) for Mac OS 

321730 How Bookmarks Are Arranged in PDF Files Created from FrameMaker 
Documents 

Acrobat (multi-component) for UNIX 

321730 How Bookmarks Are Arranged in PDF Files Created from FrameMaker 
Documents 

Acrobat (multi-component) for Windows 

320520 Bookmarks Missing in PDF File Created with PDFMaker 1.0 in Word 97 
321730 How Bookmarks Are Arranged in PDF Files Created from FrameMaker 

Documents 
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Appendix I - Adobe Acrobat Reader System Requirements 

 

Acrobat Reader 4.0  

Windows System Requirements 

n i486TM or Pentium® processor-based personal computer 
n Microsoft® Windows® 95, Windows 98, or Windows NT® 4.0 with Service Pack 3 or 

later 
n 10 MB of available RAM on Windows 95 and Windows 98 (16 MB recommended) 
n 16 MB of available RAM on Windows NT (24 MB recommended) 
n 10 MB of available hard-disk space 
n 50 MB of additional hard-disk space for Asian fonts (required for Acrobat Reader 4.0 

CD-ROM, otherwise optional) 
 

Macintosh System Requirements 

n Apple® Power Macintosh® or compatible computer 
n MacOS software version 7.1.2 or later 
n 4.5 MB of available RAM (6.5 MB recommended) 
n 8 MB of available hard-disk space 
n 50 MB of additional hard-disk space for Asian fonts (required for Acrobat Reader 4.0 

CD-ROM, otherwise optional) 
 

IBM AIX System Requirements 

n AIX® 4.1 or later 
n Common Desktop Environment (CDE) 1.0 or Motif® 
n 32 MB of available RAM 
n 12 MB of available hard-disk space 
 

DEC OSF/1 System Requirements 

n DEC OSF/1 version 4.0 or later 
n 32 MB of available RAM 
n 12 MB of available hard-disk space 
 

HP-UX System Requirements 

n HP 9000 Series Workstations model 700 or higher 
n Hewlett-Packard HP-UX version 9.0.3 or later 
n X Window System X11R5 with HP-VUE or Common Desktop Environment (CDE) 1.0 

or later 
n 32 MB of available RAM 
n 12 MB of available hard-disk space 
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SGI IRIX System Requirements 

n Silicon Graphics® IRIXTM; 5.3 or later 
n 32 MB of available RAM 
n 12 MB of available hard-disk space 
 

LINUX System Requirements 

n Red Hat Linux® 5.1 or later (non-glibc versions) or Slackware Linux 2.0 or later (non-
glibc versions) 

n 32 MB of available  
n 12 MB of available hard-disk  
 

Sun Solaris X86 and Sun Solaris SPARCstation® System Requirements 

n SunTM SolarisTM 2.3 or  
n Sun OpenWindowsTM 3.0 or later, Motif 1.2.3 or later, OpenLook 3.0, or Common 

Desktop Environment (CDE) 1.0 or later 
n 32 MB of available RAM 
n 12 MB of available hard-disk space 
n Note: Acrobat Reader will not run under SunOSTM or Solaris 2.0, 2.1, or 2.2. 
 

Acrobat Reader 3.0  

Windows 95 System Requirements 

n i386™, i486, Pentium, or Pentium Pro processor-based personal computer 
n Microsoft Windows 95, or Windows NT 3.51 or later 
n 8 MB of RAM (16 MB recommended) available to Acrobat Reader 
n 10 MB of available hard-disk space 
 

Windows NT System Requirements 

n i386, i486, Pentium, or Pentium Pro processor-based personal computer 
n Windows NT 3.51 or later 
n 16 MB of RAM (24 MB recommended) for Acrobat Reader 
n 10 MB of available hard-disk space 
 

Windows 3.1 and 3.11 for Workgroups System Requirements 

n i386, i486, Pentium, or Pentium Pro processor-based personal computer 
n Microsoft Windows 3.1 or Windows 3.11 or later 
n 8 MB of RAM available to Acrobat Reader 
n 5 MB of available hard-disk space (12 MB recommended) 
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Macintosh and Power Macintosh System Requirements 

n Macintosh® with a 68020 or greater processor, or Power Macintosh 
n 3.5 MB of RAM (5 MB for Power Macintosh) available to Acrobat Reader (8 MB 

recommended) 
n Apple System Software version 7.0 or later (version 7.1.2 recommended) 
n 12.5 MB of available hard-disk space 
 

Web Browsing Issues 

Netscape Navigator 3.0 or later is recommended for viewing PDF files inside a Web 
browser. Netscape Navigator 2.0 can be used with limitations; for example, it will not allow 
you to submit a PDF form, and operations such as printing PDF files from within Netscape 
Navigator 2.0 can crash your Mac. You may also be able to use other Web browsers that 
fully support the Netscape APIs.  

If you have more than one Navigator folder on your hard disk or you wish to view PDF files 
within the window of another Netscape-compatible browser, copy PDFViewer to its plug-
ins folder. If you have multiple versions of Netscape Navigator, be sure that the plug-ins 
folder associated with the version of Netscape you'll be using contains PDFViewer version 
1.0. (You can see the version using the Finder's Get Info command.) 

To access URLs embedded in PDF files when using Acrobat Reader outside of a Web 
browser, you must specify your preferred Web browser in Acrobat Reader's Weblink 
Preferences dialog box. From the Edit menu, choose Preferences/Weblink/WWW 
Browser Application. 

 

UNIX® System Requirements 

n 12 MB of disk space for Acrobat Reader 
n System with 32 MB of RAM 
 

Sun SPARCstation System Requirements 

n SunOS 4.1.3 or 4.1.4 or Solaris 2.3, 2.4, or 2.5 
n OpenWindows (version 3.0 or later), Motif window manager (1.2.3 or later), OpenLook 

version 3.0, or Common Desktop Environment (CDE) 1.0 and above 
 

HP Series 9000 Workstation,Model 700 or Greater System Requirements 

n HP-UX 9.0.3 or later 
n X Window System™ X11R5 with HP-VUE or CDE 1.0 
n 12 MB of available hard-disk space 
n A 32-MB machine 
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IBM RS/6000 Workstation System Requirements 

n AIX 4.1 or later operating system 
n Common Desktop Environment (CDE) or the Motif window manager 
 

Silicon Graphics Workstation System Requirements 

n IRIX 5.3 or later operating system software 
n 12 MB of available hard-disk space 
n A 32-MB machine 
 

Linux* Workstation System Requirements 

n Intel® 80x86-based computer 
n Linux 1.2.13 or later kernel 
n (The Acrobat Reader for Linux was built on a 2.0.0 kernel.) 
n *Reader with Search not available for Linux. 
 

Digital UNIX Workstation System Requirements 

n Digital 21x64-based computer 
n Digital UNIX 4.0 or later 
n 16 MB of available hard-disk space 
n 32 MB of RAM 
 

OS/2 System Requirements 

n i386, i486, Pentium, or Pentium Pro processor-based personal computer 
n IBM OS/2 Warp or Warp Connect 3.0 or later (IBM OS/2 Warp 4.0 recommended) 
n Fixpak 26 required for printing using OS/2 Warp 3.0 or Warp Connect 3.0 
n 4 MB of application RAM available to Acrobat Reader 
n 8 MB of RAM available for system 
n 5 MB of hard-disk space, plus 5 MB of temporary space available during installation 
n Netscape Navigator 2.02E or later for viewing PDF files inside a Web browser 
 

Installation Issues 

You can't install into the same directory from which you run the install program. You can't 
execute the installer from a path that has spaces in it. 

 
 

 


